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Safety Precautions

1 Electricity Safety

1.1 Check the power supply voltage, confirm that it meets the power supply voltage value

required by the instrument before insert the power plug of the instrument into a new

electric socket. Make sure that phase wire, neutral wire and ground wire are connected

correctly. Ground wire in the electric socket must be well grounded.

1.2 Check the power cord regularly and replace or repair the power cord with damaged

insulation in time.

1.3 The product is still connected to the grid power supply when the power switch is set to

“off”. Please do not dismantle the product shell without authorization, to avoid the

danger of electric shock to the human body. Please disconnect the power plug from the

grid power supply before disassembling the instrument.

1.4 Graphite furnace analysis requires the use of high-power electrical supply equipment,

for which customer need to contact a professional electrician for laboratory circuit

modification during installation. During daily use, users should not change the power

supply line as well as power supply mode, so as to avoid abnormal power supply or

equipment operation failure, which may cause danger.

2 Gas Safety

2.1 Regular leak inspections should be carried out on the gas supply pipelines and gas

connections, at least once every six months

2.2 The most used gas for flame analysis in atomic absorption spectrophotometers is

acetylene. Acetylene is flammable and explosive. It is easy to generate metal acetylene

when it contacts with metal elements such as gold, silver, copper, and mercury. It may

explode when exposed to heat or vibration. Users must carefully grasp the characteristics

of acetylene and the safety requirements for storage, transportation and use, and operate

in strict accordance with the regulations.

2.3 Besides argon, hydrogen must be used to provide a reducing environment when the

atomic absorption spectrophotometer uses a small electrothermal atomization device for

analysis. Seeing that hydrogen is flammable and explosive, users must carefully grasp the
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characteristics of hydrogen and the safety requirements for storage, transportation and use,

and operate in strict accordance with the regulations.

2.4 Combustible gas cylinders such as acetylene, hydrogen, etc. should be placed in the

instrument compartment or equipped with a dedicated gas cylinder cabinet at a distance

more than 10m. The gas cylinder room is forbidden from all sources of fire and items that

may cause sparks and flammable spontaneous combustion. Keep the room ventilated and

cool. Acetylene, hydrogen and other combustible gas cylinders are forbidden to place

with oxygen cylinders in the same room. Argon cylinders more than three meters away

from the instrument is exception. Protect the gas pipeline from collision, extrusion,

baking and chemical corrosion.

2.5 High-pressure gas cylinders must be reliable fixed during use to ensure safety.

3 Operation Safety

3.1 The instrument comprises high voltage modules. Private disassembly may cause gas

leakage and other hazards. It is forbidden to touch, disassemble, replace the internal

components of the instrument without permission.

3.2 Some cathode metals of hollow cathode lamps can be harmful to human and pollute the

environment. Hollow cathode lamps with poison metals should be disposed properly and

cannot be discarded carelessly when the lamps are damaged or scraped.

3.3 Since the analysis tail gas may contain volatile toxic substances, the instrument must be

used in a well-ventilated environment, and the operators must undergo strict operation

training. Solutions containing pollutants such as heavy metals and highly corrosive

components can poison the human body and pollute the environment. For this reason,

those solutions should be properly recycled and treated in accordance with the

laboratory's toxic substance processing methods. Do NOT dump them at will.

3.4 During igniting, the surface of the atomizer and the adjacent area will generate high

temperature. The operator should not touch the flame atomizer system during the analysis

process (or within a short time after the analysis is completed) for fear of empyrosis or

other dangers.

3.5 Since large current during the analysis process will cause elevated temperatures and high

luminance on the surface and adjacent area of graphite furnace tungsten wire

electrothermal atomizer, the operator should not touch the atomizer system or direct view
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the graphite furnace during the analysis process (or within a short time after the analysis

is completed) for fear of empyrosis, retinal damage or other dangers.

3.6 Do not apply graphite tubes and heating wire components from other manufacturers to

our products. The discrepancy of the tube contact surface and resistance will cause the

damage of the atomization system, and even cause safety hazards such as abnormal

heating of the instrument and fire on the electrical contact surface.

3.7 Some models of instruments are equipped with a constant magnetic field background

correction device. An inter-field magnetic field still exist near the constant magnetic field

atomizer although the instrument switches off. Avoid using general iron and steel tools.

Special tools must be used for operation. Be careful not to bring items and equipment

which are easily magnetized, such as watches, pacemakers, etc., near the magnetic unit of

the instrument.

4 Data Safety

4.1 The computer configured with the instrument should be controlled to use USB to prevent

computer poisoning or data loss.

4.2 It is strictly forbidden to use the dedicated computer for the instrument to surf the Internet,

install other program software from unknown sources, or use game floppy disks, CD-

ROMs, etc. to avoid the infringement of viruses on the computer and the system paralysis.

5 Warning Symbols

Operators must follow the instructions in the user manual or the warning information on the

instrument regardless of operating the instrument or maintaining or repairing the instrument. The

following is a list of warning symbols.

Hot surface Voltage, Be careful Grounded terminal
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1.1 Product features
This product is DW-180B atomic absorption spectrophotometer (hereinafter referred to as

the instrument), which can be used for flame atomic absorption spectrometry analysis and is 

widely used in geology, metallurgy, non-ferrous metals, environmental protection, quality

supervision, food, medicine, disease control, chemical industry and other industries to carry 

out element trace and trace analysis. In addition, this product has the following features:

 Win7, Win10 and other environment Chinese software, easy to use, friendly interface,

support data output and editing in Excel, Word and other formats, built-in expert

database system, avoid reading manuals during the analysis process.

 The instrument adopts a fully automatic lamp stand with 8 lamp positions (optional 2

lamp positions can be plugged into a high-performance hollow cathode lamp), with

functions such as automatic rotation, automatic switching and collimation, and multi-

lamp lighting and preheating.

 The instrument has various automatic and intelligent functions such as automatic

peak-finding setting and scanning, automatic setting of slit width and energy,

automatic wavelength optimization, and no need to reset when switching wavelengths.

 The instrument has a built-in reliable safety monitoring and protection system, which

monitors the flame state in real time, and has the functions of automatic flameout and

alarm protection when abnormal air pressure, gas leakage, etc. are abnormal.

 The instrument supports the expansion of various functions and accessories such as

hydride method, flame emission method, oxygen-enriched air-acetylene high

temperature flame method, and flame autosampler.

Note: The slit group and wavelength scanning mechanism of the instrument are

key components, and users should not adjust, repair, modify or replace them by

themselves.
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1.2 Main working principle

1. Basic principle:

The light source emits characteristic wavelength radiation light of the element to be

measured, which is absorbed by the ground state atoms of the element to be measured

in the sample vapor generated by the atomizer, and the change in the energy of the

characteristic wavelength radiation light is measured. The functional relationship

between the energy change and the concentration of the element to be measured

(Beer's law), can be used to calculate the content of the element to be measured.

2. The working principle of the background correction device:

The D2 lamp background correction device uses the different absorption of the atomic

spectral lines and the molecular spectral lines of the generated double beams with

different characteristics to deduct the influence of the background absorption signal

on the atomic absorption signal.

When the characteristic emission line of atomic spectrum in the radiation light of

hollow cathode lamp (corresponding to the wide pulse radiation of hollow cathode

lamp when the self-absorption effect is corrected) passes through the sample, it is not

only absorbed by the atomic vapor of the element to be tested in the sample, but also

absorbed by the vapor of the coexisting substance. The generated atomic absorption

signal plus background absorption signal denotes as AA+BG.

When the continuous spectral radiation of the D2 lamp passes through the sample, it is

absorbed by the coexistent vapor in the sample to be tested to generate a background

absorption signal. At the same time, there is also a small amount of atomic absorption

signal at the same wavelength of the atomic characteristic line, which is recorded as

AA'+BG'.

Assuming that the background absorption signals generated by the two optical signals

are equal (BG=BG'), the net atomic absorption signal after subtraction can be

obtained: (AA+BG)-(AA'+BG')=AA-AA' .

3. If you have to have an in-depth understanding of the working principle of atomic

absorption spectroscopy, please refer to relevant professional articles.

4. The functional association between each system unit is shown in Fig. 1- 1.
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Fig. 1- 1 System function association block diagram

1.3 Instrument structure

Fig. 1- 2 Schematic diagram of the instrument structure

The instrument is composed of light source system, atomizer, optical system, detection

system, gas circuit system, electrical system, background correction system and other

functional modules or components.

 Light source system: It is located on the left side of the upper layer of the instrument,

using a hollow cathode lamp as the light source, which is an 8-lamp lamp holder, which
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supports multi-lamp lighting.

 Atomizer: Located in the middle of the lower layer of the instrument, the 180B type

instrument is equipped with a flame atomizer, which adopts a one-button automatic

ignition design, supports manual adjustment of the height and front and rear position of

the burner, and supports 360° rotation of the burner to adjust the sensitivity.

 Optical system: Located on the right side of the upper layer of the instrument, except for

the optical path, it is mainly composed of a C-T grating monochromator and the

supporting optical path. Parameters such as wavelength and spectral bandwidth are

automatically controlled by the host computer.

 Detection system: Located on the right side of the upper layer of the instrument, in the

monochromator cover, it is composed of a wide-spectrum high-sensitivity

photomultiplier tube and an electrical signal detection and processing unit.

 Air system: located on the left side of the lower layer of the instrument (below the light

source system), the control panel is exposed, and the interior adopts a small modular

design with multiple safety protection devices.

 Electrical system: located on the rear side of the instrument (not marked in the figure),

composed of power supply module, light source signal processing, electrical control and

other units, responsible for the communication between the instrument and the software,

automation functions, data acquisition and processing functions, etc.

 Background correction system: not marked in the figure, the instrument uses a

deuterium lamp background correction system, and the correction light source is located

next to the light source system.

1.4 Main parameters

 Wavelength range: working wavelength 190nm~900nm.

 Light source system: 8 lamp position design (can be extended to 2 lamp positions to

connect high-performance hollow cathode lamps).

It has functions such as automatic rotation of the lamp stand, automatic switching and

automatic collimation, and supports multi-lamp lighting.

 Optical system: Czerny-Turner type monochromator, grating line density 1800/mm, blaze
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wavelength 250nm.

Focal length: 277mm.

Spectral bandwidth: 0.1nm/0.2nm/0.4nm/0.8nm/1.6nm/2.4nm six gears automatic

switching;

Automatic peak setting and scanning, automatic setting of slit and energy, automatic

wavelength optimization.

 Atomizer: The single flame atomization system is adopted, and the burner can be adjusted

up and down, back and forth, and rotated in multiple dimensions.

10cm all-titanium burner for air-acetylene flame (optional flame-emitting combustion

head);

Adopt high-reliability gas flow control system, with automatic control such as automatic

ignition/extinguishing.

With foot reading function, effectively liberate the hands of analysts.

 Protection measures: real-time monitoring of flame state, air pressure, etc., automatic

flameout and gas circuit and alarm when abnormal.

After the instrument is powered on, it monitors gas leakage in real time, and automatically

shuts off the gas circuit and alarms when it is abnormal.

 Software communication: all Chinese intelligent operation software, support

Win7/Win10 and other operating systems.

The instrument status is automatically optimized with one key, and it supports multi-task

analysis.

Automatically fit the working curve, automatically reset the slope, automatically calculate

the concentration, sample content, etc.

The measurement is repeated 1 to 99 times, and the average, standard deviation and

relative standard deviation are automatically calculated.

Test data or final analysis report, etc., support direct printing or export and editing in

Excel and Word.

 Dimensions and weight: The size of the instrument host is about

1010mm(L)×480mm(W)×550mm(H), and the weight is about 65kg.

 Equipment power: The instrument host adopts single-phase alternating current

(220V±22V), and the average power consumption is less than or equal to 0.3kVA.
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1.5 Warranty description
Our goods come with guarantees of refund, repair or replacement and the factory is

responsible for free warranty if it fails in normal use within 15 months (including the quality

objection period of 3 months after delivery). We have the right not to assume the warranty

responsibility under the following conditions:

 The instrument cannot be restored or damaged due to unauthorized disassembly by the

user.

 This instrument is a precision measuring instrument and is strictly prohibited to be

placed in a strong corrosive gas, humid or dusty environment. Such as deterioration and

damage caused by pollution and corrosion of optical parts, electrical parts and other parts

due to unsatisfactory working environment.

 Damaging to instruments or parts due to violation of regulations, wrong operation or

improper handling.

 Damage caused by irresistible factors.
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2.1 Working environment
2.1.1 Transportation and storage requirements
During transportation, it must be protected from rain, exposure to sunlight and severe impact.

The instrument should be stored in the original box in the warehouse or indoors and kept

properly. Environmental conditions that should be met during transportation and storage:

1) When transporting and storing with packaging, the temperature range is required to be

-40℃~55℃, and the relative humidity is required to be≤95%RH.

2) When transporting and storing with packaging, avoid rain, exposure, inversion,

serious bumping, and falling from high places.

3) During transportation, it should also be noted that the tilt drop height is less than or

equal to 250mm.

2.1.2 Basic safety requirements for electrical protection
Under normal working conditions, the instrument meets the requirements of the

corresponding clauses of GB 4793.1-2007:

1) Anti-shock type: Class II equipment.

2) Degree of protection against electric shock: Type B equipment.

3) Degree of protection against harmful liquid ingress: common type.

4) Working system: intermittent operation

2.1.3 Working environment requirements
In order to complete the installation and debugging of your instrument correctly and

smoothly, the instrument workplace and facilities must meet the following conditions. For 

other more detailed installation and use conditions, please refer to "DW-180B Atomic

Absorption Spectrophotometer Installation Confirmation Letter".

2.1.3.1 Laboratory environment

1) Areas with an altitude of≤4000 meters.

2) The indoor ambient temperature is 5°C~35°C (temperature difference ≤2°C), and the

suitable ambient temperature range is 15°C~30°C.
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3) Indoor relative humidity ≤ 80% (25°C), suitable relative humidity ≤ 70%, install

dehumidification equipment in humid areas.

4) There is exhaust equipment in the room, there is no strong magnetic field interference

in the room, there is no vibration that hinders the normal operation of the instrument,

there is no open flame, no electric heating and equipment that is easy to generate

electric sparks.

5) The room is clean, dry and free of corrosive gases, and the instrument room must be

separated from the chemical laboratory and sample room.

6) The worktable is strong and firm (load bearing ≥150kg), and the recommended size

is≥2.4m in length,≥0.8m in width, and 0.7m~0.8m in height.

7) When the workbench is placed, leave space on the left and right sides and at the back,

which is convenient for connecting the gas circuit and overhauling the instrument, etc.

8) The placement reference of instruments, accessories and computers, as shown in

Figure 2.1 below.

9) A standard lightning rod should be installed on the top of the outer wall of the

laboratory, and its entry point should be far away from the working ground wire.

10) The computer dedicated to the instrument should not be plugged into storage devices

with unknown security, or use game floppy disks/CDs, etc.

11) The laboratory should be equipped with air exhaust equipment. The air outlet should

be 1.2m~1.5m away from the work surface, and the air outlet should be≥20×20cm2.

The recommended air exhaust volume is 10m3/min~30m3/min, and a piece of paper

should be attached to the air outlet. It is advisable that the place can be gently sucked

(the air volume is too large, which will affect the flame stability). The installation of

the exhaust equipment is shown in Fig. 2- 1 below.

12) The exhaust equipment should be made of metal, avoid the use of plastic products,

which will soften due to heat/high temperature.
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Fig. 2- 1 Schematic diagram of the placement of instruments, computers and other accessories

Fig. 2- 2 Schematic diagram of the exhaust system

2.1.3.2 Power supply environment

1) To ensure the stable operation and safety of instruments and equipment, the ground

wire should be connected to a metal plate directly buried 1.5m underground with an

area of more than 1m2.

2) The AC power supply of the instrument is 220V±22V, 50Hz±1Hz, which meets the

peak power of the instrument≥ 0.5kW.
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3) The instrument is powered independently, and the instrument/computer is powered,

which is required to be separated from the air compressor and other equipment.

4) In areas where the voltage is too high, too low, unstable, and noisy, etc., the power

supply should be equipped with a regulated power supply.

5) Refer to Fig. 2- 3 below for the power supply wiring method and socket specifications.

Fig. 2- 3 Schematic diagram of power supply wiring and socket specifications

Notes: 1) On-site installation focus on checking the power supply/grounding. Use a

socket tester (as shown in Fig. 2- 4) to insert into the power supply socket of

the instrument. The wiring should be correct, the fire-to-ground should not

exceed 220V±22V, and the zero-to-ground fluctuation should not exceed ±2V

≤1V.

2) Check the fluctuation of power supply voltage and noise after the laboratory

ventilation equipment is turned on.

Fig. 2- 4 Special socket tester
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2.1.3.3 Air supply environment

1) Air: The user can choose our air compressor or self-configured air compressor. The

outlet pressure of the air compressor is required to be adjustable at about 0.30MPa,

the pressure difference change is ≤0.01MPa, and the operating pressure must not be

lower than 0.20MPa. The factory standard 5m pipeline, if it exceeds this length,

please bring your own.

2) Acetylene: User should prepare acetylene gas source (40L steel cylinder) and special

acetylene pressure reducer/meter, and flashback preventer/stop valve. The gas purity

requirement is not less than 99.9%, and the pressure difference change is less than or

equal to 0.01MPa. The using the pressure shall not be lower than 0.05MPa or exceed

0.1MPa. The factory has equipped the 10m pipeline. If it is shorter than what you

need, please bring your own.

3) Storage requirements: Acetylene cylinders should be stored in a separate room with

good ventilation. The cylinders should be placed firmly, securely, and not easily

toppled. They should not be too far away from the work area. There should be a

safety alarm device in the room.

Notes: Fire sources and oxygen sources are strictly prohibited near the acetylene

gas source or in the same room. Users must understand the safety precautions for

the use of other acetylene gas and meet the safety requirements

2.1.3.4 Other items to prepare

1) Users should purchase hollow cathode lamps and standard solutions for each element

according to their own analysis tasks.

2) The user should prepare the high-grade pure acid (commonly used nitric

acid/hydrochloric acid), other quantitative determination tools, pre-treatment

equipment, etc.

3) The number of covered plastic buckets with a capacity of 5L~10L provided by the

user (used to hold waste liquid and deionized water), pay attention to the buckets for

different purposes should be clearly marked to distinguish, and do not use glass

containers to hold waste liquid.

4) Users should prepare common tools such as flat /cross screwdriver, large adjustable

wrench, needle-nose pliers, claw hammer and so on.
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2.2 Instrument installation process

2.2.1 Confirmation of installation conditions
After the instrument arrives, the goods should be checked and received immediately

according to the order contract. Check whether the name and quantity are consistent with the

contract and the waybill, and check whether the package of the instrument is in good

condition after transportation and whether there is any obvious damage. If there is a problem,

lodge a representation with the cargo carrier.

Before starting the installation, the user should fill in the "Installation Confirmation Letter"

item by item and return it to our company for confirmation before installation.

After the installer arrives at the user site, the following contents should be confirmed and

checked again.

1) Power supply quality inspection: use a socket tester or similar equipment to check, it

is required that the fire/zero/ground wire is connected correctly (especially the ground

wire is good), the voltage between the neutral wire and the ground wire is less than or

equal to 1.5V, and the voltage between the live wire and the neutral wire is within

Between 198V~242V and the voltage fluctuation should not exceed ±5V.

2) Gas source inspection: Check the quality of acetylene gas. Industrial acetylene (99%

and below) should not be used. Acetylene decompression gauges and flashback

preventers are available, and acetylene cylinders should be stored in a separate room

with good ventilation.

3) Laboratory inspection: focus on confirming indoor air quality (clean, dry, non-

corrosive gas), workbench size and location, good power supply lines, air

conditioning and dehumidification equipment, exhaust equipment, etc., and confirm

that the instrument room must be Separate chemical laboratory and sample room.

4) Please confirm and check other installation conditions according to the actual

situation on site.

Note: If the installation conditions are not available on site, the removal of the

packing box, instrument installation and debugging should not be carried out, and

the unpacking can only be carried out after the user has completed the rectification

and confirmed that the installation conditions are met.
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2.2.2 Product unboxing and spare parts inspection
1. Unbox the instrument

1) Prepare the working conditions of the instrument and the necessary laboratory

conditions as required, and then install the instrument according to the instructions in

this chapter.

2) When unpacking the instrument, it is recommended to directly remove 10 bolts on the

lower edge of the wooden packing box, so that the packing box can be lifted up and

removed as a whole, which is convenient for the subsequent transportation of the

instrument.

3) After the instrument is unpacked, check whether the instrument is damaged after

transportation. If any problem is found, it should be reported to the relevant parties in

time.

4) Take the instrument and purchased accessories and accessories out of the packing box

and place them in the laboratory.

2. Spare parts and key information inspection

1) According to the packing list of various types of instruments and accessories, sort out

with the user item by item, confirm and tick item by item, and report back to our

company immediately if any missing or damaged is found.

2) The key information on the product certificate, such as model number, factory serial

number, and production date, must correspond to the product nameplate, which is

located at the lower left corner of the back of the instrument.

2.2.3 Instrument Installation

2.2.3.1 Instrument placement

1) Place the instrument: place the instrument host on the workbench, and place the

computer on the left side of the instrument.

2) Instrument leveling: Adjust the three adjustable feet at the bottom of the instrument so

that all six feet are placed on the table to ensure that the instrument is placed stably

and firmly.

3) Physical placement reference, as shown in Fig. 2- 5below.
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Fig. 2- 5 Schematic diagram of physical placement of DW-180B instrument

2.2.3.2 Circuit installation

Note: The internal electrical system wiring of the instrument has been connected

before leaving the factory. Do not loose, change, or disassemble at will.

1) The electrical connection port of the instrument is located in the middle of the back of

the instrument, as shown in Fig. 2- 6below.

2) Instrument power supply: Check that the instrument switch is off and plug the power

cable in the spare parts into the power supply socket and the power socket on the back

of the instrument.

3) Communication connection: Plug the communication cable in the spare parts into the

communication port on the back of the computer and the instrument.

4) Accessory connection: Connect the foot reading cable in the spare part to the

accessory interface on the back of the instrument.

5) Other equipment connection: The air compressor, hydride generation device and other

equipment configured by the user shall be connected in circuit according to the

instruction manual of the equipment and shall be separated from the power supply

line of the instrument host and computer.
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Fig. 2- 6 Schematic diagram of each electrical interface on the back of the instrument

Gas paths installation

Note: The air supply pipeline inside the instrument has been connected and leaked

before leaving the factory. Do not loose, change, or disassemble at will.

1) Installation of air source:

a) Install the air compressor, filter and other components according to the instruction

manual of the air compressor and connect the power supply as required.

b) Air compressor test: power-on start → pressure regulating filter assembly is normal

→ outlet pressure can be adjusted.

2) Installation of acetylene gas source:

a) According to the corresponding gas circuit requirements in "2.1.3 Working

Environment Requirements", configure and store the acetylene gas source.

b) The outlet end of the acetylene cylinder pressure regulator must be equipped with a

tempering stop valve for acetylene.

c) When opening and closing acetylene, a special opening and closing wrench of the

main valve of the acetylene cylinder should be used, and the use of an adjustable

wrench is prohibited.

d) When the total pressure of the acetylene cylinder is less than or equal to 0.3MPa, the

cylinder must be replaced with a new one.

3) Installation of the gas path at the instrument end:

a) The gas connection port of the instrument is located on the right side of the back of
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the instrument, as shown in Figure 2.6 above.

b) Air path: use the spare part Φ8×1 blue PU pipe to connect the air source outlet → the

gas-liquid separator inlet;

c) Use the spare part Φ6×1 blue PU tube to connect the outlet of the gas-liquid separator

→ the air interface of the instrument;

d) Acetylene circuit: use the spare part Φ7×3 red rubber tube to connect the acetylene

gas source outlet→ the C2H2 interface of the instrument;

e) ④ [Only models with extended high temperature flame function] Oxygen circuit: use

spare Φ 7× 3 blue rubber tube to connect the oxygen gas source outlet → the O2

interface of the instrument;

f) When connecting the external pipeline of the instrument, it can be cut to an

appropriate length as needed. The connection diagram is shown in Figure 2.7 below.

Fig. 2- 7 Schematic diagram of each gas path interface and gas path connection on the back of the instrument

4) List of pressure settings for each gas path:

Acetylene cylinder outlet pressure (MPa) 0.07~0.09

Air compressor outlet pressure (MPa) 0.26~0.30

Outlet pressure of air path gas-liquid separator (MPa) 0.20~0.22

Oxygen cylinder outlet pressure (MPa) 0.06~0.08

Leakage inspection

a) After the pipeline is installed and before the official start-up, use soapy water to check

whether there is air leakage in each interface and pipeline.
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b) The cause of the air leakage should be found out, and the damaged pipes, joints, etc.

should be resealed or replaced.

c) Check whether the explosion-proof plug at the rear of the flame atomizer is well

sealed, otherwise it is easy to flash back when the flame is ignited.

Note: The gas-liquid separator provided with the instrument is a differential

pressure automatic drainage type. When the accumulated water reaches a certain

level, it will automatically drain the water, and the valve will automatically close

after it is drained.

2.2.3.3 Driver and PC software installation

1) Computer requirements: 32/64-bit Win7, Win10 Professional/Ultimate; built-in

Microsoft .NET Framework 4.0 or above; pre-installed Microsoft Office software.

2) Workstation software (AAS) installation:

a) Before installation, please exit all running applications, run the installation program

"Setup.exe" file, the application software installation wizard starts to run, and the user

completes the following installation steps step by step according to the installation

wizard.

b) Click "Next" to enter the user information setting page, enter the user's username and

unit information.

c) Click "Next" to enter the installation path page, it is recommended to use the default

installation path.

d) Click "Next" to enter the installation preparation page, click the "Install" button to

start the software installation.

e) After the software is installed, click "Finish" to exit the installation wizard.

f) Double-click the "AAS" icon on the desktop to run the application software.

Note: When installing the software, be sure to uninstall other versions of the

software left in the computer, and close the software such as 360 Guard, firewall,

etc., which may cause the problem that the software cannot be installed normally on

some computers.
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The main components of the flame atomization system of the DW-180B instrument are 
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shown in Fig. 2- 8 below.

Fig. 2- 8 The composition of the flame atomization system of the instrument

2.2.4.1 Flame atomizer calibration and adjustment

When installing the flame atomization system of the DW-180B instrument, it is necessary to 

correct the front and rear positions and the angle of the burner when necessary, and the upper 

and lower positions are manually adjusted freely without correction.

1) Correction of the front and rear position of the burner: Light up the hollow cathode

lamp such as Cu element (providing a light spot that is clearly visible to the naked

eye), place the "flame cleaning card" in the spare part on the upper end face of the

burner, and the converging light spot of the hollow cathode lamp can be observed. , as

shown in Figure 2.9. Loosen the front and rear fixing screws of the atomizer, the front

and rear positions of the atomizer can be adjusted as a whole, so that the light spot is

in the left and right center position, and then tighten the atomizer screws after

adjustment.

2) Burner angle correction: translate the card left and right, if the light spot is observed

to deviate from the left and right of the combustion gap, it means that the burner has a
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rotation angle. By rotating the angle of the burner, the light spot is aligned with the

gap of the burner on the whole stroke. At this time, the rotation angle of the burner is

0° (parallel to the optical path), the sample optical path is the longest, and the flame

sensitivity is the highest.

Fig. 2- 9 Adjust burner position/angle

3) Adjustment of the angle of the combustion seam: Usually, the user does not need to

adjust the angle of the combustion seam. However, when measuring high-

concentration samples. To obtain a good linear relationship between the absorbance

value and the sample concentration, the sensitivity can be artificially reduced by the

rotation angle of the combustion slit. When the rotation angle of the burner is 90°, the

sample optical path is the shortest and the flame sensitivity is the lowest.

4) Adjust the burner up and down: The default height is 5mm to 8mm from the lower

edge of the light spot to the upper end face of the burning seam. The lift knob can be

manually rotated to control the burner to move up and down, so as to freely adjust the

height of the combustion seam to ensure ideal detection sensitivity under different gas

conditions.

5) Up and down position locking: If you do not pursue the best detection sensitivity of

each element, you can fasten the "lift locking knob", at this time, the upper and lower

positions of the combustion seam are constant.

Note: When you need to adjust the up and down position of the flame, you must

first loosen the "lifting lock knob", otherwise the internal adjustment device of the

atomizer will be deformed or damaged.
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2.2.4.2 Waste pipe installation and water seal

Install the instrument waste line and prepare an appropriate container to receive the waste. In

addition, in order to prevent air leakage from the waste liquid pipe, the liquid in the waste

liquid pipe must be maintained in a certain amount to maintain the water pressure, so as to

play a sealing role (water seal).

The waste liquid nozzle of the flame atomizer is at the front and bottom of the atomizer mist

chamber on the front of the instrument. One end of the waste liquid pipe has been installed on

the waste liquid nozzle, and the other end is knotted (do not overtighten the pipeline to cause

deformation) and fill it with water as a water seal.

Note: 1) During daily flame analysis, be sure to check and ensure that the water seal

is good to prevent backfire explosion and gas leakage.

2)Waste liquid may produce corrosive and harmful gases and should be

cleaned frequently.

2.2.4.3 Nebulizer inspection

The fog chamber and atomizer components are the core components of the flame atomization

system, as shown in Fig. 2- 10

Fig. 2- 10 The fog chamber and atomizer structure of flame atomizer

The analytical sensitivity and detection limit of the instrument flame method depend to a

large extent on the working state of the atomization system. Refer to the following

procedures for disassembly and inspection of the atomizer:

1) Remove the four screws fixing the nebulizer base by hand (pay attention to hold the

nebulizer base when removing the last screw), remove the nebulizer base, you can see

that the nebulizer is clamped on the nebulizer base.
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2) Open the air path, you can feel the air flow from the front end of the nebulizer, put the

suction pipe of the nebulizer into the deionized water, and the nebulizer starts to

absorb water to produce atomization.

3) Gently hold the rear cap body of the impact ball cap (do not directly touch the impact

ball at the front end), slowly rotate and fine-tune its front and rear, and observe the

atomization effect of its front end, with the mist airflow "forward cone symmetry",

The larger the included angle, the fan-shaped surface is spread out, and the mist is

light and even without sudden jump" is better.

4) After adjustment, the connecting rod that hits the ball cap should be located within a

range of 45° downward.

5) After the atomizer is checked and adjusted, close the air circuit and take the suction

tube out of the deionized water.

6) Install the nebulizer base back on the spray chamber, and after checking that the O-

ring is in the proper position, tighten the four fixing screws diagonally gradually.

2.2.5 Power-on online check
The customer service personnel should conduct power-on inspection on the instrument after

the above-mentioned work such as power connection, gas connection, inspection, etc., to

ensure that the instrument is in good condition, and then carry out the instrument acceptance

work together with the user. The power-on online inspection should include but not be

limited to the following:

1) The instrument is powered on normally, and there should be no abnormal electrical

noise or smell.

2) Enter the software, the instrument communicates normally.

3) The following functions are normal in the initial test:

i) 8 lamp positions can be lit normally.

ii) Switching lamp position, wavelength setting/resetting, slit switching function,

normal response and no abnormal sound.

iii) Press the "multi-function button" on the gas circuit control panel on the left side

of the instrument to start the ignition function and hear the sound of ignition.

4) Turn on the gas source, and check that the instrument should have no gas path
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blockage or gas leakage problem, and there should be no gas leakage alarm.

5) Check the water seal in the waste pipe again.

2.3 Instrument acceptance work
2.3.1 Overview
Before acceptance, please read the instrument manual carefully, understand the functions of

various controllable parts of the instrument, and be familiar with the operation methods and

steps of the instrument, and then start to operate the instrument with power on.

After the customer service personnel have completed the above power-on and online

inspections, the instrument can be checked and accepted after ensuring that the instrument is

in good condition. In the process of acceptance and experiment, the verification of various

acceptance indicators should be carried out together with the user. After the index acceptance

is completed, the customer should be explained and trained in basic instrument principles,

basic analysis knowledge, instrument operation, and daily precautions.

Note: 1) The special plane is dedicated, and the person is responsible. Do not arbitrarily

change the software and parameter files in the computer. 2) Do not let irrelevant

personnel fiddle with the switch of the instrument or disassemble the parts of the

instrument at will.

2.3.2 Acceptance conditions

1) Acceptance conditions:

i. The acceptance work of the instrument should be carried out under the conditions

in accordance with "2.1 Instrument working environment";

ii. Pay special attention to the common factors that seriously affect the normal

operation of the equipment, such as power supply conditions (power stability,

noise and grounding conditions, etc.), working environment (indoor temperature

fluctuations, humidity, corrosive gases);

Note: Due to the harsh environmental conditions, the test results of the instrument

will not meet the standard, unexpected failures, and the reliability and life will be

deteriorated.

2) Notes:

i. The standard working solution used for acceptance should be prepared and

measured immediately. If the storage time is too long, the concentration value has
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a large error;

ii. When preparing the standard working solution, it is necessary to prevent the

pollution caused by various factors and avoid abnormal results.

2.3.3 Acceptance content
Before acceptance, the instrument and corresponding hollow cathode lamp should be

preheated for 30min.

The inspection of each index or function shall be carried out according to the following

acceptance conditions and methods.

1. Lamp position check

Requirements: The 8 lamp positions of the instrument are all lit normally;

Conditions: Any element lamp can be used, the lamp current is 3mA;

Method: The instrument has 8 lamp positions, and each lamp position is energized and

checked separately.

2. Wavelength indication error and repeatability

Requirements: The wavelength indication error does not exceed ±0.20nm, and the

wavelength repeatability is less than or equal to 0.08nm;

Conditions: detect with mercury lamp at 253.7nm, 546.1nm, 871.6nm, lamp current 3mA,

spectral bandwidth 0.2nm;

Method: Select Hg element, select the spectral bandwidth 0.2nm in the instrument condition

page, enter the above wavelengths in the wavelength column respectively, click

"Auto Wavelength", the software will convert the found peaks into wavelengths and

display them. The measurement was repeated three times in one direction, and the

maximum value was recorded as the wavelength indication error, and the difference

between the maximum value and the minimum value was the repeatability.

3. Spectral bandwidth deviation

Requirements: spectral bandwidth deviation does not exceed ±0.02nm;

Conditions: use a copper lamp to detect at 324.7nm, lamp current 3mA, spectral bandwidth

0.2nm;
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Method: Select Cu element, wait for it to stabilize, scan the 324.7nm spectral line ±2mn

under the condition of spectral bandwidth of 0.2nm, and automatically calculate the

full width at half maximum of the spectral line peak;

Spectral bandwidth deviation = (full width at half maximum - 0.2) nm.

4. Baseline Stability

Requirements: 1) Static baseline drift within 30min≤0.003Abs, baseline instantaneous noise

≤0.001Abs;

2) Dynamic baseline drift within 15min≤0.003Abs, baseline instantaneous

noise≤0.003Abs;

Conditions: Detect at 324.7nm with copper lamp, spectral bandwidth 0.2nm or 0.4nm, lamp

current 3mA;

Method: The instrument and lamp are preheated for 30min, and the optimized energy is≈

100%. Click to select the icon of measurement stability in the toolbar at the top of

the measurement page, the baseline stability window will pop up, set the time length

of 30min, set the damping constant to 0.5s, and start the measurement after zero

adjustment, this is the static baseline stability;

Dynamic baseline stability, after the flame is ignited, set the time length of 15min,

damping constant is set to 1.0s or 2.0s, other conditions are the same as the static

baseline stability, and the measurement starts after zero adjustment, this is the

dynamic baseline stability;

The baseline drift value (the difference between the maximum value and the

minimum value of the reading at the center of the baseline) and the baseline

instantaneous noise value (the maximum instantaneous peak-to-peak value)

measured by both should meet the requirements.

5. Detection limit, characteristic concentration, sensitivity, linearity error, repeatability

of flame analysis

Requirements: flame method for copper detection, detection limit≤0.003μg/mL,

characteristic concentration≤0.03μg/mL, sensitivity≥0.15Abs/(μg/mL),

linearity error≤5%, repeatability≤0.5%;
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Conditions: use a copper lamp to detect at 324.7nm, spectral bandwidth of 0.2nm or 0.4nm,

damping≤2.0s, and other instrument parameters adjusted to the best working

state. Pay attention to select the appropriate atomization conditions: acetylene

flow (1.1~1.5) L/min;

Method: Prepare copper standard solution: the mass concentrations are (1.0, 3.0, 5.0) μg/mL,

and the medium is 0.5% nitric acid aqueous solution;

Blank: 0.5% nitric acid aqueous solution;

1) The blank solution was measured 11 times, the standard solution was measured 3

times each, and the 1.0 μg/mL copper standard solution was measured again 7 times;

2) After the curve measurement is completed, the detection limit (DL) and

characteristic concentration (CC) of the flame method analysis are automatically

calculated;

3) Analysis sensitivity of flame method: slope of calibration curve;

4) The ratio of the back-calculated concentration at the middle point of the curve

(3.0 μg/mL) to the theoretical value, after subtracting 100%, is the linear error of the

flame method analysis;

5) Continuously measure 1.0 μg/mL copper standard solution for 7 times, and

automatically calculate the relative standard deviation (RSD), which is the

repeatability of the flame analysis.

2.3.4 Acceptance result disposal
The purpose of acceptance is to check whether the quality of the instrument has declined due

to transportation, storage, etc., resulting in the failure to meet the requirements of use, and to

find out the reasons for the deterioration of performance, so as to deal with it in time.

During the acceptance, the selected instrument parameters, acceptance methods, test results

and phenomena should be recorded. If it is found that a certain performance does not meet

the requirements, the acceptance record can be provided to the factory so as to find out the

reason and repair it.

Note: Analysis indicators such as detection limit are closely related to the selection

of conditions and parameters. When the measurement is out of tolerance or there is

a problem, the functional parameters such as atomizer height and atomization

conditions should be re-adjusted to obtain good results.
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3 Instrument Operation

3.1 Daily analysis process
3.1.1 Operation flow chart

Turn on the computer, turn on the exhaust system, turn on the dehumidification/air conditioning equipment,
etc.
↓

Install the element under test hollow cathode lamp
↓

Check the circuit and gas connection of the instrument
↓

Turn on the gas source, the gas circuit needs to be checked regularly for leaks
↓

Turn on the power of the instrument, wait for the completion of the host initialization and self-test, run the
operating software, and establish communication

↓

Create an analysis task
↓

Set various instrument parameters and measurement conditions, and adjust the instrument to achieve the
optimal working state

↓

Measurement of standard blanks and standard samples
↓

Check the working curve
↓

Measure sample blanks and unknown samples
↓

Complete analysis tasks and store/output data results
↓

Close the gas source (the acetylene gas should close the main valve of the cylinder when the flame is ignited
to release the remaining gas)

↓

Close the software, close the instrument
↓

Turn off computers and other electrical equipment to ensure a clean lab

Fig. 3- 1 Operation flowchart



Drawell International Technology Limited

32

3.1.2 Flame Analysis Flowchart

Fig. 3- 2 Flame analysis flowchart
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3.2 Basic instrument operation
3.2.1 Preparations before the experiment

1) Read the safety instructions carefully before operation.

2) Check that all parts of the instrument (instrument host, computer and main accessories,

such as gas cylinders, etc.) are connected correctly.

3) Turn on the computer and prepare paper and ink cartridges for the printer.

4) Open the exhaust system in the work area.

5) Check that the air source is sufficient, connect the power supply of accessories such

as the air compressor, and adjust the outlet pressure of the air source to the

appropriate pressure value.

6) Wait for the air compressor to reach the working pressure value, and install the

hollow cathode lamp on the lamp stand (before starting).

7) For instruments with optional accessories such as automatic sampler, you need to turn

on the power supply of the corresponding accessories first, and then turn on the power

supply of the host.

8) After the accessories are turned on, turn on the power switch of the instrument host.

9) Double-click the AAS icon on the computer desktop to enter the software and start

using the instrument.

3.2.2 Analysis process

3.2.2.1 Instrument Communication

In the main interface of the software, click the "Communication" icon and wait for the device

to communicate normally after self-checking.

3.2.2.2 Task establishment

1) There are different operations depending on whether to carry out "new tasks" or continue

"previous tasks".

2) New tasks:

i) Click the "New" icon to pop up the "Create Analysis Task" window, as shown in

Fig. 3- 3 below.

ii) Click the "Select Method" button, select the method to be used in the pop-up
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method selection window and confirm, and return to the "Create Analysis Task"

window.

iii) Select the lamp position corresponding to the element and click "OK" to enter the

measurement page.

3) If you want to continue the "previous task", click the "Open" icon, select the task to

continue analysis according to the storage path, and click OK to directly enter the

measurement page.

Fig. 3- 3 Creat an analysis tast

3.2.2.3 Instrument Alignment

1) Automatically enter the "Instrument Alignment" window, as shown in Figure 3.4.

2) Wavelength adjustment: After confirming that the element to be analyzed and the

lamp position are correct, click the "Auto WL" button and wait for the automatic

wavelength optimization of the instrument to complete. At this time, the energy

should be close to 100%.

3) Adjust the light stand: Click the "Up" or "Down" button located in the middle left

position, no more than 3 times in one direction (this button is used to control the up

and down fine adjustment of the light stand, to eliminate the influence of the

concentricity deviation of different elements), until find the maximum energy in this

process, at this time the energy is usually > 100%.
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4) Constant high pressure: Click the "Auto Gain" button at the upper right position, wait

for the automatic optimization of the negative high-pressure value of the instrument to

complete, and the energy should be close to 100% at this time.

5) Check that the "PMT" value at this time should be consistent with the PMT value

after optimization of the element before (the deviation does not exceed ±10V) and the

energy signal is stable, and the optimization of the optical conditions of the

instrument is completed.

6) Click the "OK" button in the lower right corner of the "Instrument Optimization"

window to return to the measurement page.

Fig. 3- 4 Instrument optimization

3.2.2.4 Sample addition

Click the "Sample Sheet" icon to pop up the "Sample " window, as shown in Fig. 3- 5. In this

window, you can perform operations such as "Add", "Amend", "Delete" and "Save". You can

also enter this window to adjust the sample at any time during the analysis process
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Fig. 3- 5 Sample sheet

3.2.2.5 Test analysis

1) Ignition operation:

a. Check that the water seal is good, the waste liquid is not overfilled, the air circuit is

opened as well as the pressure is about 0.22MPa, and the acetylene circuit is open,

and the pressure is about 0.08MPa. Check that the instrument has no abnormal

alarm, and the indoor ventilation is good.

b. Press the "multi-function button" on the gas circuit control panel on the left side of

the instrument, the instrument will automatically eject the ignition flame, slowly

turn the acetylene flow knob (counterclockwise) to supply gas and ignite the flame

at the combustion seam.

c. If there is air left in the gas pipeline, the flame cannot be ignited at one time. It is

necessary to press the "multi-function button" to turn off the alarm (no flame is

detected), and then press the "multi-function button" again to ignite.

d. Depending on the length of the pipeline, this operation may be repeated several

times to successfully ignite the flame.

Note: If the above method still fails to ignite or there is a pungent smell of acetylene

leakage in the room, please check the gas circuit or contact the manufacturer, and do

not ignite with an open flame without authorization to avoid danger.
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Fig. 3- 6 The main page of measurement

2) Analytical readings:

a. The main page of measurement is shown in Fig. 3- 6 above.

b. After igniting the flame, put the suction tube of the atomizer into deionized water, and

click the "Zero" button (shortcut key "Z") to perform zero adjustment operation.

c. During the experiment, attention should be paid to adjusting zero in deionized water

in time to ensure that the baseline can always be zeroed to ensure the accuracy of the

analysis results (especially when analyzing low-level samples).

d. After putting the nebulizer pipette into the corresponding solution, visually observe

that the absorbance curve begins to rise due to liquid suction until it remains stable,

and then press "Analyze" (shortcut key "space") to automatically sample the

instrument.

e. Test the standard blank, standard solution, sample blank and sample solution one by

one in sequence.

3) Temporary flameout: When the measurement is suspended or the flameout needs to

be turned off in an emergency, press the "multi-function button" to complete the

flameout.

3.2.2.6 Data view

1) In the "Calibration" insert page in the main page of point measurement, you can view

the curve, mask points, modify the number of blanks, etc.
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2) In the "Results Data" insert on the main page of point measurement, you can view test

data, data reanalysis, etc., and the data table can be exported to Excel.

3) Click the "Signal Graph" inset in the main page of measurement, you can view the

original signal diagram of all test data, etc.

4) The " Report" insert in the main page of point measurement can output data results

and reports in various formats, and the report can be exported to Word.

5) Click the "Save" button on the main measurement page to save the current analysis

task/data. When the task is saved, it will be stored as a AAS file in *.AAS format, and

the save path will be specified when it is saved for the first time.

Note: Microsoft Office software needs to be pre-installed to use the function of

exporting to Excel/Word.

3.2.3 Shut down after experiment

1) After the work is completed, before turning off the fire, the flame atomization system

should be cleaned by suctioning and spraying deionized water for about 10 minutes.

2) Close the acetylene cylinder tightly, and automatically extinguish the flame after

burning off the gas in the pipeline.

3) Exit the AAS software and turn off the power switch of the instrument host.

4) Turn off other accessories such as air compressor and flame autosampler.

5) If the laboratory is not used for other purposes, turn off the computer, other electrical

equipment, and exhaust system to keep the laboratory clean.
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4 Daily maintenance

4.1 Maintenance precautions
Please read the instruction manual of the instrument carefully before using the instrument, so

as to avoid unnecessary shutdown of the instrument for repair.

In addition, some of the most basic and important considerations are still worth highlighting

before the user opens the instrument for repair in order to troubleshoot. In particular, it is

necessary to mention that some parts of the instrument are difficult to restore once

disassembled. Users must not disassemble the instrument by themselves. If there are

special circumstances, the manufacturer must obtain written permission. The manufacturer is

not responsible for the major damage to the instrument caused by the user's unauthorized

disassembly.

Please pay attention to the following matters when maintaining the instrument:

1. Be sure to unplug the power cord of the instrument when troubleshooting will open the

instrument cover or cover to repair some parts.

2. Before maintenance, cut off the gas source and water source, and close the main valve of

various gas cylinders, especially the main valve of gas cylinders.

3. When disassembling or restoring, do not let screws, washers, etc. drop inside the

instrument. If they are accidentally dropped, they must be taken out.

Note:

1) When checking and maintaining the inside of the monochromator, be careful not

to touch the working surface of the optical element.

2) Before removing the monochromator cover, the high voltage line of the

photomultiplier tube must be unplugged first.

4.2 Parts replacement and adjustment
Some parts or components of the atomic absorption spectrophotometer are consumables or

wearing parts, and should be replaced after a period of use.

Such as D2 lamps, hollow cathode lamps, graphite tubes, graphite cones, filters, etc., all have

a certain life and are consumables, while nebulizers, impact balls, burners, etc. are wearing

parts. Over time, these parts or components will corrode and damage and need to be replaced.
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Although some are not consumables or wearing parts, but the instrument has been used for a

certain period of time, there is also corrosion and wear, such as various optical parts and

electronic components of the optical system. In short, damaged parts need to be replaced.

Some parts need to be adjusted after replacement to ensure the performance of the instrument.

4.2.1 Replacement and Adjustment of Hollow Cathode Lamp
Hollow cathode lamp is the main light source of the instrument, and its working life is

generally about 5000mA*h, but specific to different elements, the corresponding hollow

cathode lamp life is very different. At the same time, the life of the hollow cathode lamp is

also related to the working current used. After the hollow cathode lamp reaches its working

life, the performance indicators such as light intensity, spectral line width, and noise value

will deteriorate, which will affect the analytical performance of the instrument, and a new

hollow cathode lamp needs to be replaced.

The replacement of the hollow cathode lamp is very simple, because the lamp needs to be

changed frequently during the analysis and testing. The replacement method is to hold the

metal part of the element lamp and unplug the lamp from the lamp socket, plug the hollow

cathode lamp of the element to be tested and put it on the lamp stand, taking care not to

contaminate the light-transmitting window.

Note: The protrusions on the pins of the hollow cathode lamp are aligned with the

grooves of the lamp socket when plugging in the lamp.

4.2.2 Replacement and adjustment of D2 lamps

1. The working life of the deuterium lamp is generally given as a minimum of 500h, so

after the end of its life, the deuterium lamp needs to be replaced. When replacing, use the

deuterium lamp model matched with the instrument. In addition to paying attention that

its external dimensions should be the same as the original, it should also be noted that its

working parameters must meet the conditions:

Parameters
Anode
current
（mA）

Tube
pressure
drop DC
（V）

Filament
voltage AC
（V）

Filament
current
（A）

Ignition voltage
DC（V）

Requirements 300 70 10 0.5 ≥200
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2. The deuterium lamp used in this instrument has four leads. The red is the anode lead, the

yellow is the auxiliary electrode lead, and the two black lines are the filament lead;

Note: When connecting the leads, be careful not to make virtual connections or

wrong connections, and do not touch the deuterium lamp window with your hands.

3. When installing the deuterium lamp, please pay attention to align the deuterium lamp

window with the half mirror. The deuterium light spot is very small, and the light should

be carefully aligned after replacement. If the adjustment is not good, it will affect the

energy output of the deuterium lamp, which will overlap with the hollow cathode light

spot and affect the effect of background correction. The adjustment method is:

a. Turn on the deuterium lamp and the input current are about 50mA, adjust the slit to

0.2nm, and turn on the Cd lamp for 1.5mA.

b. Use paper to block the light in the middle of the burner to see the hollow cathode lamp

and the deuterium lamp spot and adjust the upper end and side screws of the deuterium

lamp frame to make the two beam spots overlap.

c. The instrument automatically finds the peak and then adjusts the energy of the

deuterium lamp to maximize the BG energy and complete the replacement of the

deuterium lamp.

Note: Adjust the spot position after lighting the deuterium lamp, be careful not

to touch the high temperature deuterium lamp glass shell to avoid burns.

4.2.3 Replacement of the nebulizer
The atomizer is the core component of the atomizing combustion system. The sensitivity and

detection limit of the instrumental flame analysis and determination largely depend on the

working state of the nebulizer. At the same time, the atomizer is the only channel for the

sample to enter the atomization system. The suction capillary, nozzle, and impact ball are

directly corroded by the sample solution, so they should be rinsed with deionized water after

each experiment.

When the working condition is not satisfactory, you should check whether the nebulizer

needs to be replaced or cleaned. The replacement method of the nebulizer is:

1. Remove the four screws and small corners that fasten the nebulizer base, remove the

nebulizer base, and gently remove the impact ball in front of the nebulizer.
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2. Pinch the metal seat on the rear of the nebulizer and slowly remove the nebulizer. To clean,

soak the glass part of the nebulizer in acid.

3. To clean or replace a new nebulizer, please install it in the order from 2 to 1 above, it

should be noted that:

a.When installing the nebulizer, turn the neck part connecting the impact ball to the

bottom, otherwise the stability of the instrument will be affected.

b.When tightening the four screws, do not miss the matching sealing ring, and the four

screws should be tightened evenly and symmetrically to avoid air leakage and tempering.

4.3 Routine maintenance of the instrument
4.3.1 Light source system

4.3.1.1 Deuterium lamp

1) When using a deuterium lamp, it should not be turned on and off frequently, so as not

to affect the service life.

2) It is forbidden to touch the light-transmitting window of the deuterium lamp with your

fingers. After replacing the deuterium lamp, be sure to wipe off the stains on the

window with the mixture, and then turn on the deuterium lamp.

4.3.1.2 Rotating the light stand

1) When the instrument is working, the lamp holder is driven by the motor to rotate the

precise shaft holder to change the lamp. Do not move the lamp holder by hand in the

live state.

2) It is recommended to use fixed lamp positions for long-term analysis lamps to reduce

the number of lamp disassembly and the adjustment and optimization time of lamp

positions.

3) After the shutdown, the opened lamp room door should be put down in time to

minimize dust falling into the lamp room.

4) During the regular maintenance of the instrument, use a cleaning cloth to wipe off the

dust and stains in the lamp frame, socket, and lamp room.
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4.3.1.3 Hollow Cathode Lamp

1) When using a hollow cathode lamp, you should be very careful when loading and

unloading to prevent breaking and cracking and pay attention not to contaminate the

light-transmitting window. If it is stained with oil or fingerprints, it will attenuate the

light energy emitted by the cathode, especially the short-wave energy. If stains are

found, use absorbent cotton dipped in a mixture of ethanol and ether (ratio 1:3) to

wipe off the stains. To pick and place the lamp, you should take the lamp socket.

2) Hollow cathode lamps cannot be left unused for a long time. If the storage time is too

long, the lamp will not be able to light up or can not be used normally due to air

leakage, gas adsorption, release, and other reasons. Therefore, lights that are not

commonly used should be lit for 2 to 3 hours every 3 to 4 months. Users should pay

enough attention to this, otherwise the lamps will be scrapped in batches. If they

cannot be lit, use the positive and negative polarity reverse activation method.

According to the characteristics of hollow cathode lamps, it is recommended not to

buy hollow cathode lamps that are not in use prematurely.

3) The lamp removed from the lamp stand should be put into the lamp box in time, and

should not be placed anywhere on the workbench, and should not be mixed with

various steel tools to avoid cracking or scratching the hollow cathode lamp bulb.

4) If the element lamp is broken, the cathode material will be exposed, and some

element materials are harmful to human health, so please do not discard them at will,

and handle them according to the standard methods for the disposal of toxic and

hazardous substances in analytical laboratories.

4.3.2 Optical system

4.3.2.1 Notes

Moisture and dust protection in the laboratory is a necessary condition to prolong the service

life of the optical system. Since the expensive and moisture-resistant optical parts cannot be

recovered after damage, the main part of the optical system is sealed and protected. Users

should not touch the exposed optical parts (such as lenses), and do not disassemble the cover

at will.

4.3.2.2 External optical path part

1) Always pay attention to the cleanliness of the lens. If you find that there is dust on the
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surface, you can use a clean blower to blow it. If there are fingerprints or other stains,

apply absorbent cotton dipped in an appropriate amount of ethanol and ether mixture and

wipe gently. Be careful not to scratch the surface.

2) The lens used in the instrument is an achromatic lens, which is precisely assembled and

difficult to restore after disassembly by non-professionals. Do not disassemble the lens

unless necessary.

3) It is absolutely forbidden to touch the surface of the aluminum-coated half-reflector that

constitutes the beam combiner in the lamp room, nor can it be touched or wiped with

anything.

4.3.2.3 Monochromator section

a. The monochromator is located on the right side of the upper part of the instrument and is

sealed by a special cover. It is a precious and precise part and needs special dust and

moisture resistance.

b. Users should not open the monochromator without authorization! If it is confirmed that

the spectroscopic system is faulty, please contact the manufacturer first and have it

handled by professionals.

c. If it is confirmed that the sealing cover needs to be opened to view the internal

conditions of the monochromator, please observe the following requirements:

a. First, unplug the negative high voltage line of the photomultiplier tube.

b. Confirm that the laboratory is in a dry, clean, and closed environment, and close the

exhaust duct system above the instrument.

c. Personnel who are inspecting in front of them must wear work caps and masks to

inspect and should try to hold their breath as much as possible, and do not talk to

other personnel, so as not to contaminate the grating and reflector with saliva and

breath.

d. If there is dust on the surface of the reflector and grating, you can use a clean and dry

blower to gently blow it.

e. If there are slight stains or mildew on the surface of the reflector and grating, you

must contact the manufacturer for replacement and repair. It is absolutely forbidden to

touch the surface, and it is also forbidden to use lens cleaning paper or absorbent
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cotton to wipe.

Note:

1) After opening the monochromator cover, do not touch the grating and reflector, let

alone wipe it with any objects;

2) If the surface of the optical parts in the monochromator is stained or otherwise, be

sure to contact the manufacturer to solve it.

4.3.3 flame atomization system
The samples analyzed by the instrument are often corrosive. In order to ensure the durability

and good performance of the instrument, the user should regularly clean and maintain the

atomization system.

The flame atomizer consists of a nebulizer (atomizer), a pre-mixing chamber (mist chamber),

a burner, and the like. The sample will pass through the system during testing, so each part is

in an acidic environment for a long time, requiring the user to routinely clean the system after

each use, and should maintain it regularly.

4.3.3.1 Daily cleaning and maintenance

1) After a group of samples is analyzed, proceed as follows: continue to ignite the flame

and spray deionized water for about ten minutes to remove any trace samples from the

analysis system; spilled solution droplets (especially organic solution droplets) should be

be removed; dump the filled waste liquid in time.

2) Regular maintenance. The atomizing burner system should be cleaned once a week,

including the nebulizer, the fog chamber, and the burner. If the analyzed sample has a

high concentration or a turbid solution, it should be cleaned once a day after the analysis.

3) Use organic phase spray, or spray high-concentration Cu, Ag, Hg and other salt solutions

in the air-acetylene flame and clean it immediately after work. Because the possible

formation of unstable acetylene compounds are easy to explode. For cleaning after

spraying the organic phase, first spray the organic solution that is mutually soluble with

the sample for 5 minutes, then spray acetone for 5 minutes, spray 1% nitric acid again for

5 minutes, and finally spray deionized water for 5 minutes.

4.3.3.2 Maintenance of the nebulizer

1) Cleaning should be carried out after the daily operation is completed. When testing

samples with high pH,   the cleaning time should be appropriately extended.
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2) The regular maintenance cycle is determined according to the nature of the test sample

and the amount of test tasks. For general water samples and a small amount of testing

tasks, maintenance can be performed every 7 to 10 days. When testing viscous samples

or turbid samples frequently, the maintenance interval should be shortened appropriately.

3) The metal-covered glass nebulizer of this instrument is fine and fragile, and the nebulizer

seat is made of acid-resistant non-metallic materials, which are hard in texture but have a

slightly poorer edge resistance to cold shock. Please handle with care, do not bump or

drop.

4) If the front end of the capillary tube in the nebulizer is blocked during operation, do not

use a metal filament to poke it, as this will easily damage the glass parts. The correct way

to clear the blockage is to use compressed air to backflush or reverse the air. For organic

solvent blockages, the nebulizer needs to be removed from the nebulizer seat, and the

front end is inserted into the potassium dichromate washing solution to dissolve the

blockage.

5) If there are deposits at the nozzle of the nebulizer after long-term use, it will reduce the

liquid absorption and affect the test sensitivity. The nebulizer seat can be removed, the

impact ball can be removed, and then the nebulizer can be taken out and cleaned with

lotion.

6) If the plastic pipette is bent so that it is inconvenient to use, it can be pulled out and

soaked in boiling water to soften, straightened and cooled before use.

4.3.3.3 Burner cleaning and maintenance

Flame ignition should be uniform and stable. If the flame is not uniform or changes

abnormally, it often indicates that the combustion seam is blocked. How to remove sediment:

1) Without disassembling the burner, the cleaning method is to turn on the air compressor

and blow in air, and at the same time carefully scrape along the seam with a piece of

paper or a thin card, and use the air to blow off the scraped deposits. Be careful not to

scratch the seam, you can also wash it with corrosive soap to wash off the deposits.

2) Hold both ends of the burner and turn and pull up to remove the burner. Put the burner

into an ultrasonic cleaner for cleaning, or soak it in 5% HNO3 for 8 hours before

brushing off the dirt. After cleaning, rinse it with deionized water and dry it, and put it

back in the reverse order of removal.
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4.3.3.4 Cleaning and maintenance of the fog chamber

1) The fog chamber (pre-mixing chamber) of this instrument is made of acid-resistant non-

metallic materials, with a hard texture, but its edge is slightly less able to withstand cold

shock. The maintenance requirements are the same as those of the sprayer, and the

regular maintenance cycle is determined according to the nature of the analyzed samples

and the amount of analysis tasks.

2) Remove the burner, pour 50mL of deionized water into the upper neck of the fog

chamber each time, and let the water drain away from the waste liquid pipe, and rinse it

several times.

3) If the purpose of cleaning the fog chamber still cannot be achieved, use a surfactant

solution to clean it, and then rinse it with deionized water.

4) The inner wall of the fog chamber should be cleaned with water or solvent and should

not be scratched with metal or hard objects. If the instrument is suspended for a period,

the fog chamber should be cleaned.

5) The connection between the neck of the fog chamber and the burner is sealed by an O-

shaped rubber ring. Note that when removing the burner from the neck of the fog

chamber, slowly rotate the burner and pull out the combustion head along the neck of the

fog chamber. Do not use excessive force to prevent damage to the neck of the fog

chamber.

Note: Do not forcefully impact or twist the mist chamber and the sprayer seat.

When dismantling the sprayer seat, handle it with care to avoid bumping.

4.3.4 Flame gas circuit module
The flame gas circuit module inside the instrument is relatively independent and is located

below the instrument lamp room. The external system is composed of air compressors,

acetylene cylinders and other gas source supporting pipelines. Routine and regular

maintenance and maintenance work should be carried out on the gas circuit system of the

instrument.

The flame gas circuit module is composed of a gas supply control unit (the color of the

pipeline is orange-red) and the control unit of the auxiliary gas supply (the color of the

pipeline is blue). The maintenance of this module should pay attention to:

1) The use time of the filter is related to the cleanliness of the gas used. If the filter is
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found to be clogged, the spare parts should be replaced. Use a wrench to remove the

joints and air nozzles at both ends of the old filter, and install them on both ends of

the new filter. Note that the installation direction should be consistent, and do not

miss the gasket in the joint.

2) During the operation of the instrument, pay attention to the water storage condition of

the pressure regulating filter. The pressure regulating filter is an automatic drainage

type, and it will automatically discharge when the stored water reaches a certain

amount. If there is too much water and still cannot be discharged, check whether the

pressure regulating filter is faulty and repair it.

3) Regularly check whether the pipes, valves, joints and other parts are leaking due to

connection or material aging. If there is any leakage, it should be repaired or replaced

in time. If the air compressor or the pressure reducing valve for the air source is faulty,

please contact the manufacturer for maintenance.

4) Always check whether there is water in the air compressor and remove it in time. The

water in the gas-water separator should also be discharged frequently to prevent water

from entering the instrument.

5) Before the flame analysis, the pressure of the acetylene cylinder must be checked. For

the air-acetylene flame, the new gas must be replaced when the pressure is less than

0.3MPa. Otherwise, it is easy to cause acetone in the cylinder to escape, affect the

flame state and reduce the flame temperature, and even block the precision

components inside the instrument, resulting in economic losses or safety problems.

4.3.5 electrical system

1) For instruments that do not work often, the power should be turned on regularly to

make the entire circuit system energized to work to avoid damage to circuit

components due to long-term shelving. Especially in the humid areas in the south, it

should be noted that the instrument is often energized to prevent the circuit system

from being damp and moldy, resulting in short-circuit faults and corrosion of circuit

components.

2) For instruments that have been used for a long time, the dust accumulated on the

electrical system should be removed by brushing the dust on the circuit board with a

soft brush or vacuuming the dust, and the dust on the other electrical parts should also
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be carefully removed. Pay special attention to the cables and circuit boards must be

firmly connected after cleaning.

Note: The instrument is strictly prohibited to be placed in the chemical

laboratory, reagent room or sample preparation room. The acid gas and other

corrosive gases in the above room will cause serious and irreparable damage to

the electrical system of the instrument in a short period of time.
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5 Instruction of the software operation
You should be familiar with the Windows operation software and computer before you use

this software.

5.1 Enter the software
Turn on the computer, accessories of the instruments and the instrument. Then double cilck

the AAS icon to enter the software. As shown in the Fig. 5- 1.

Fig. 5- 1 Enter the AAS software

5.2 Control parts of the software
The upper parts of the main interface are the control icons of this software, including the

menu bar and the tool bar. You can use all the functions of this software through these two

bars.

5.2.1 Menu bar
The menu bar include six menu: files, tool, language, and help. As shown in Fig. 5- 2.

Fig. 5- 2 Menu bar

1. File

As shown in , in this menu, you can using the measurement function.
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"New": Creat a new measurement task.

"Open": Open a file that used before.

"Close": Close the current tast.

"Save": Save the current task.

"Save as": Save the current task as a file in another disk.

"Print": Print the current interface.

"Print Preview": Preview the content printed.

"Print Setup": Set the print parameters.

"Exit": Quit the AAS software.

2. Tools

As shown in the Fig. 5- 3, this list contains the control of analysis methods and

instrument parameters.

Fig. 5- 3 Tools bar

"Communication": Build or break down the communication between the AAS software

and main unit. After the instrument communication is completed, it will automatically

recognize the model and suffix of the instrument, and start the corresponding function

according to the corresponding configuration

"Analysis methods": Edit the analytical methods. It is allowed to create new method,

alter, or delete the existing method.
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‘Instrument Alignment’: Adjust the instrument parameters to get the optimizing operating

conditions.

'Flame Align': To adjust the parameters of the flame atomization.

'Autosampler Align': Using to preparate and adjust autosampler when the instrument is

equipped with a flame or graphite furnace autosampler.

‘Baseline’: To measure the base line stability of the instrument.

3. Help menu

‘About AAS’: Users can view information about AAS software, view or configure

instrument models, and configure database functions through the Help menu.

5.2.2 Tool Bar
The tool bar is just under the menu bar in main interface. It includes several short cut

buttons which help to carry out the functions of the AAS software. As shown in Fig. 5- 4.

Fig. 5- 4 Tools Bar

The functions of the short cut buttons in the tool bar are respectively as the following

from left to right:

‘Method’: Be same as the menu ‘Tool→Analytical Method’.

‘USB Connect’: Be same as the menu ‘Tool→USB Comm.’.

‘Measuring Parameters’: To setup the ‘Measurement Time’, ‘Delay Time’ and the

‘Damping Constant’.

‘Next Project’: Switch to the next project.

‘Instrument Alignment’: Be same as the menu ‘Tool→Instrument Alignment’.

‘Burner Alignment’: Be same as the menu ‘Tool→Burner Alignment’.

‘Sample Table’: To view and edit sample table.

‘Recalibrate’: Select a standard sample to check and reset the slope of

calibration curve.

‘Baseline’: Be same as the menu ‘Tool→Baseline’.

‘About AAS’: Be same as the menu ‘Help → AAS”.
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5.3 Design of Analysis Task
Select the menu ‘File →New’ or click the button on the toolbar to enter the ‘Design of

Analysis Task’ window (As shown in Fig. 5- 5).

Fig. 5- 5 Design of Analysis Task

In this page, the information about the analysis task can be edited, such as ‘Applicants’,

‘Laboratory Name’, ‘Operator’, ‘Batch NO.’, and ‘Analysis date’.

This instrument can carry out multi element analysis task. One analysis task can carry out

the determination of up to six element analysis items. In the item list, select the analysis

method and add items in the order of analysis successively. The columns from left to right

in the item list are the "analysis order", the measured "element", the "analysis method"

and the corresponding element "light position".

5.3.1 Select Method
Click the ‘Method’ button in Fig. 5- 5to enter the ‘Analytical Method’ window (As shown

in Fig. 5- 6). If there was already exist an applicable analytical method in the methods list,

just choose it and then click ‘OK’. And if there is not, the user should click the ‘Create’

button to create new method.

Mission information

Project List
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Fig. 5- 6 Analytical Method

5.3.2 Create, Amend and Delete

Fig. 5- 7 Method

To create a new method, please click the ‘Create’ button in Fig. 5- 6 to enter the ‘Method’

window (As shown in Fig. 5- 7).

To amend an existing method, please select the method in the methods table, and then

click the ‘Amend’ button in Fig. 5- 6 to enter the ‘Method’ window (As shown in Fig. 5- 7)

also.

To delete an existing method, please select the method in the methods table, and then

click the ‘Delete’ button to delete it.

‘Analysis mode’: There are three options: ‘FAAS, FAES, and GFAAS’. DW-220A include 

all three options and users can choose one they need;

‘Signal Type’:When using flame method, ‘Transient peak’ and ‘Time average’ can be

selected, and the default is ‘Time Average’; when using graphite furnace method, ‘Peak

height’ and ‘Peak Area’ can be selected, and the default is ‘Peak Area’.

‘Measurement Mode’: There are two options: ‘Standard Curve, Standard Addition’.
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5.3.3 Select the Analytical Element
Click ‘Element’ button in Fig. 5- 7, the ‘Periodic table of elements’ window will be

shown in Fig. 5- 8. Select the element to be analyzed and then click ‘OK’ to return

‘Method’ window.

Fig. 5- 8 Periodic table of elements

5.3.4 Instrument Conditions
After selected the analytical element, click the ‘Next’ button in Fig. 5- 7 to enter the

‘Instrument’ window (As shown in Fig. 5- 9). The instrument parameters such as

‘Wavelength’, ‘Slit’, ‘Measurement Time’, ‘Delay Time’, ‘Damping Constant’, ‘HCL

Current’, ‘AUX Current’, ‘BG Correction’, ‘D2Current’ and ‘SH Pulse Current’ can be

set in this dialog table.

Fig. 5- 9 Instrument conditions

‘Wavelength’: The default is the primary sensitive line of the element. If users want

to use the secondary sensitive line instead, click the drop-down menu to select.
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‘Slit’: Choose different slit spectral bandwidths according to the analysis of different

elements, the default value is 0.2.

‘Measurement Time’: Indicates the speed of collecting samples. The default is 1,

and users can modify by themselves.

‘Delay Time’: Indicates the time interval from start to peak. The default is 0, and

users can modify by themselves.

‘Damping Constant’: Set the damping constant, it can reduce the noise. For flame

method, it is recommended to select1~3. The default is 1, and users can modify by

themselves.

‘Signal smoothing": Products of this series have no related functions.

‘HCL Current’: Select the working current of the HCL decided by different analysis

element.

‘AUX Current’: This series of models is equipped with this function, and the

auxiliary cathode current of the high-performance lamp can be set by tick. Use of

high-performance lamps helps improve sensitivity, detection limits, etc.

‘BG Correction’: Select the mode of background correction between ‘None’, ‘D2

lamp’ and ‘Self-Absorption’. Varies according to different configurations.

‘D2 Current’: Users can choose to input D2 lamp current only after selecting "D2

lamp" in the background correction.

‘SH Pulse Current’: This series of models is equipped with this function, which is

used to input the self-absorption background correction current value.

5.3.5 Calibration Equation
Click the ‘Next’ button in the Fig. 5- 9 to get into the ‘Calibration Equation’ window (As

shown in Fig. 5- 10).

Fig. 5- 10 Calibration Equation
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‘Conc. Units’: Set the concentration unit of the samples (ng/mL, µg/mL or mg/mL).

‘Equation’: Users can select the fit one between linear equations and quadratic

equations.

‘Pass Zero’: Tick this option to calibrate curve pass through the zero point. For the

low concentration samples (even those that the concentration is lower than the lowest

concentration standard sample), chose 'Pass Zero' could decline the effect of slide of

working curve, and decline the error of measurement and calculation.

'Calib. Blank': Tick it means choose the calib blank. It will automatically deduct the

calib blank every time when measure the sample.

'Replicates of Calib. Blank': Set the measure times of the calibration blank. The

average of the calculation will be engaged in the calibaration equation.

'Injection Volume': Set the injection volume when using graphite furnace analysis.

The default of standard samples and unknown samples are 20µL.

'Automatically configure working curve': an optional setting when the graphite

furnace analysis is equipped with an automatic sampler. When this option is checked,

enter the prepared standard solution concentration in the "Standard Reagent

Concentration" column below. The automatic sampler can be used during the test.

Automatically dilute the standard stock solution according to the concentration of the

standard solution series listed on the right to prepare a working curve

'Standard S1~S10': Sequence number of the standard solution.

'Concentration' Input the corresponding concentration of the standard solution.

'Replicates': Enter the number of times to measure the standard solution, and the

average value of the calculation will participate in the curve calculation.

5.3.6 Atomization Conditions
Click the 'Next' button in the Fig. 5- 10 to get into the ‘Atomization Conditions ‘window

(As shown in Fig. 5- 11).

The atomization conditions include "flame atomic absorption method" (Fig. 5- 11), which

automatically enters the corresponding atomization conditions setting interface.

'Flame Type': According to the configuration of the instrument model, you can

choose "Air-Acetylene Flame" and "Air-Acetylene-Oxygen Flame" (only the

instrument equipped with an oxygen-enriched module has this option);
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'Flue Flow': Users can select based on the element and conditions they selected

referring to analysis manual. (Adjust flue flow manually from the front operation

panel of the instrument for the instrument equipped with a manual flow module)

'Oxygen Flow': For instruments equipped with an automatic oxygen enrichment

module, you can refer to the oxygen enrichment analysis manual and select based on

the measurement conditions of different elements; for instruments equipped with a

manual oxygen enrichment module, the oxygen flow is manually adjusted from the

operation panel on the left front of the instrument.

'Burner Height': The distance between the combustion slit of the atomizer and the

center of the optical path.

Fig. 5- 11 FAAS

5.3.7 QC Setting
Click the 'Next' button in the Fig. 5- 11. to get into the ‘QC’ window (As shown in Fig.

5- 12). This page offers the recalibration function to the calibration curve.

'Auto Recalibrate': If select this, recalibration will be inserted automatically to

control the sample quality in the sample table.

'Recalibrate Interval': Insert recalibration in the edited sample table after the set

test repetition.

'Recalibrate STD Conc': Users can input the recalibrate STD conc. either by

themselves or selected one from sample table. Click ‘Select from STD Conc. Table’,

an interface is shown as Fig. 5- 13. Select one from the list and click ‘OK’ to return.



Drawell International Technology Limited

59

Fig. 5- 12 QC

Fig. 5- 13 Select Recalibrate Conc.

After the entire above are finished setting, click ‘Ok’ button in Fig. 5- 12 to return

'Method Edit' window (As shown in Fig. 5- 6). So far it means that the creating of new

method is done. Then click ‘Ok’ button in 'Method Edit' window to return 'Design of

Analysis Task' window (As shown in Error! Reference source not found.).

5.3.8 Sample Table
Click the 'Sample' button in the Error! Reference source not found. to enter the

'Sample' window (As shown in Fig. 5- 14). Here can set whether to measure the sample

blank and its replicates times.
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Fig. 5- 14 Sample Table

Click ‘Add’ button can call out the ‘Add Sample’ window in which can add sample. (As

shown in Fig. 5- 15).

Here, you can set the ‘Sample name’, ‘Sample No.’, sample ‘Type’, ‘Intake’, ‘Diluent

volume’, and ‘Replicates’.

Fig. 5- 15 Add Sample

'Sample Name': The name of samples, which can be entered as letters, numbers and

Chinese characters.

'Sample No.': To order the samples. If the sample name, sampling volume and

constant volume are the same, users can only enter the start and end numbers,

separated by commas ",". For example, there are 15 samples in total, after inputting

"1,15" and clicking "OK", the samples are automatically expanded and arranged.

'Type': Depend on the liquid state or the solid state of the samples.

'Intake': For the liquid samples, users can select ‘mL’ or ‘µL’; for solid samples,

users can select ‘g’ or ‘mg’.

'Diluent Volume': If the sampling volume is 1mL to 50mL, the dilution volume will

be 50mL.
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'Replicates': Set the number of injection measurements for each sample, and the

measurement results will be reported in the form of average.

When the sample table setting is completed, click the ‘Ok’ button in Fig. 5- 15 to return

the ‘Sample’ window (As shown in Fig. 5- 16).

Note: Samples cannot be named with the same “Sample name + Sample number”
naming method.

Fig. 5- 16 Sample Table

‘Add’: Users can continue to add samples to be tested after the edited sample

‘Amend’: Amend the sample selected in the table

‘Delete’: Delete the sample selected in the table.

‘Open’: Open a saved sample table.

‘Save’: Save the active sample table.

'Import from Excel': Support to edit the sample sheet in Excel according to the

format requirements, and then import it into the workstation

After edition, click ‘OK’ button in Fig. 5- 16 to return to the ‘Design of Analysis Task’

interface shown as Error! Reference source not found..

5.3.9 Delete Project
At the page of Error! Reference source not found., select a project in the project table, and

then it can be deleted by click the ‘Delete’ button on the right side.

5.3.10 Select Project Samples
In the task creation interface, select an analysis item, and then click the 'Measure Sample'

button to enter the "Sample " page, where you can set which samples are analyzed for this

element item.
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After the above steps and related settings are completed, click the 'OK' button in the create

task interface to complete the "Create Analysis Task" operation. AAS software automatically

returns to the main work interface (Fig. 5- 17)

Fig. 5- 17 Main work interface

5.4 Shortcut Tools
After an analysis task is designed, the user can control, adjust, and optimize the

instrument by the shortcut buttons on the tool bar (As shown in Fig. 5- 18)

Fig. 5- 18 Shortcut Toolbar

5.4.1 Basic Operation

1. ‘New’: Be same as the menu ‘File→New’ to create a new analysis task.

2. ‘Open’: Be same as the menu ‘File→Open’ to open an analysis task.

3. ‘Save’: Be same as the menu ‘File → Save’ to save the present analysis task.

4. ‘Print’: Be same as the menu ‘File →Print’ to print the current displayed page.

5. ’Print Preview’ : Be same as the menu ‘File →Print Preview’ to previse the print.
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5.4.2 USB Connect
Turn on the instrument, click button on the tool bar to build communication between

the AAS software and the main unit of the instrument. The instrument can be operated

with various instructions through the computer application software only after the

instrument is connected to the computer.

Note: The hardware initialization and self-check will be performed automatically lasting
about 15s ～ 30s after the instrument is turned on. DO NOT communicate with the
instrument during this time.

5.4.3 Analysis Method

Click the icon in the tool bar to edit the analysis method. The function is same as the
menu ‘Tool’’Analysis Method’.

5.4.4 Measure Parameters
Click button on the tool bar can amend the measure parameters, such as measurement

time, delay time and the damping constant (As shown in Fig. 5- 19).

Fig. 5- 19 Measure Parameters

5.4.5 Task Info
Click button on the tool bar to edit or browse the information referring to analysis task

(As shown in Fig. 5- 20).

Fig. 5- 20 Task Info

5.4.6 Next Project

Click icon to switch to the next testing project after the current project completed.
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5.4.7 Instrument Alignment

Fig. 5- 21 Instrument Alignment

Click button on the tool bar to optimize the working condition of the instrument (as

shown in Fig. 5- 21). The function is same as ‘Tool’’Instrument Alignment’.

'AA': Means main light beam. It is used to adjust the negative high voltage (gain) of PMT

until the energy is in the state of 100% more or less.

'BG': To display the energy value of the background light source when using S-H method

or D2 lamp method.

'Auto Gain': During the operation, if the energy is exceeded or cannot be reached up to

100%, click Auto-Gain to balance it.

'Auto balance': Adjust the current of the reference beam and make its energy to balance

with the main light beam.

'BG Correction': Users can choose three methods of "None, Deuterium Lamp and Self-

absorption", after the modification, click the setting button at the back to take effect.

'PMT': It is used to adjust the negative high voltage of the photomultiplier tube. After the

modification, click the setting button at the back to take effect.

'Slit': It is used to adjust the spectrum bandwidth of the instrument, click the drop-down

menu to select, after modification, click the setting button at the back to take effect.

'Preheat Lamp': Adjust the Number and Current of the working HCL and preheat HCL.

And then click their Setup button to send the parameters to the main unit.
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'Reset, Up, and Down': Click Reset button, the lamp stand will rotate to the starting position

automatically. Click UP and DOWN to manually fine tune the lamp position.

'Optimize': The instrument automatically optimizes the current working light position to

obtain the maximum energy after clicking.

Wavelength: Click ‘Wavelength’ button, the instrument will automatically find out the

position around the designated wavelength. Then click - and + of ‘Fine wavelength’ to

adjust the wavelength position, and click Up and Down of ‘Lamp position’ to find out the

optimal lamp position. If the gain (negative high voltage) is too high or too low, input a

proper gain value and click “Setup”, or click “Auto-gain” to make auto-balance.

Auto-wavelength: Click ‘Auto-wavelength’ button, the instrument will automatically seek

the peak value position of the designated wavelength and the optimal lamp position.

Simultaneously, the energy of “Main” should be at 100% more or less to make the negative

high voltage of the gain being matched. (This function does not be equipped in ES types)

Wavelength scan: It shows the energy distribution of the scanning spectral line in the

designated wavelength range as shown in Fig. 5- 22. Set the "start" and "end" wavelengths

and "PMT" in the 'scan parameters'. Click the start scan button to automatically perform a

spectral scan in this range. The scanned map can be saved as a picture (*.jpg format), or it

can be previewed and printed out by clicking the print preview and print buttons.

After the entire instrument alignment was done, click Ok button to quit this interface.

Fig. 5- 22 Wavelength Scan

5.4.8 Autosampler alignment
(Only instrument which equipped an autosampler has this function)
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During the analysis, click the icon to open the autosampler setting interface (Fig. 5- 23),

where the user can configure and adjust the flame autosampler. For detailed instructions on

automatic injection, please refer to the corresponding manual.

Fig. 5- 23 Flame autosampler

5.4.9 Sample Table

You can also edit the sample table during the analysis process. Click button on the tool

bar which is shown in Fig. 5- 24. User can ‘Add’, ‘Amend’, ‘Delete’ samples and ‘Save’ the

sample table.

Fig. 5- 24 Sample Table

5.4.10 Recalibrate

Click button on the tool bar to call out the QC window. Select the corresponding

standard sample and recalibrate.
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5.4.11 Base-line

Fig. 5- 25 Baseline Stability

Click the button to test the baseline stability of the instrument, after the instrument has

been optimized. It has the same function as ‘Tool’’Baseline Stability’.

It is recommended to use Cu HCL at 324.7nm to test the baseline stability. Preheat the Cu

HCL for 30 min before the test and optimize and adjust the instrument to the best working

condition. Back to the baseline stability measurement page, set the condition and then

click ‘Zero’ to reset the absorbance to zero. After that, click ‘Start’ to start the baseline

stability test.

After the measurement is completed, click ‘Save’ to save the test result directly as a .jpg

image format. The test result can also be printed and preview by clicking ‘Print ‘and

‘Print Preview’ button.

Settings of the Baseline Stability: Click the ‘Setup’ button in Fig. 5- 25, the page will

appears as shown in Fig. 5- 26. The user can adjust the test parameters of baseline stability.

Fig. 5- 26 Baseline Stability Setting

5.4.12 About

Click the button in the toolbar to display the current version information of the AAS software,
the function is the same as the menu "Help"→ "About AAS".
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5.5 Analysis Operations
When the analysis task is designed, and all the instrument parameters are aligned, the

analysis operations can be carried out.

All the analysis works are operated in the working main interface (Fig. 5- 17). There are five

pages in this window: Analysis, Calibration, Results Data, Signal Graph and Report.

Among them, the "Analysis" tab is the work page for sample analyze, and the remaining

four tabs are the measurement results viewing, data processing, and output pages. Users

can check the pages by click the corresponding label to switch.

5.5.1 Analysis Page
The ‘Analysis Page’ with flame method is shown in Fig. 5- 27, and the ‘Analysis Page’

with graphite furnace method is shown in Fig. 5- 28. Both include the areas of ‘Graph

Display’, ‘Working State’, ‘Absorbance’, ‘Control Button’, ‘Results’. The graphite

furnace also includes ‘Step’.

‘Graph Display’: In the area of coordinate system, there will show the dynamic curve of

absorbance-time when sample measuring. The graph parameters can be set by click ‘Set

Graph’ button to call out ‘Graphics setting’ window (As shown in Fig. 5- 29).

‘Working State’: Show the measure progressing, reminder the next sample.

‘Absorbance’: Real-time display the absorbance.

‘Control Button’: Click the ‘Measure’ button to start the sample measurement; click the

‘Zero’ button to adjust the absorbance by adding a standard blank or sample blank to the

atomizer; click the ‘Set Graph’ button to adjust the absorption curve axis parameters.

‘Results’: Display the current sample measurement results, and the average of multiple

measurement results, SD and RSD values, etc.
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Fig. 5- 27 The Analysis Page of Flame Method

Fig. 5- 28 The Analysis Page of Graphite Furnace Method

Fig. 5- 29 Graphics Setting

Working State

Graph Display

Absorbance

Control Button

Results

Working State

Graph Display

Absorbance

Control Button

Results

Step
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Taking Cu 1.0µg/mL, 3.0µg/mL and 5.0µg/mL standard series as examples, the operation

steps are briefly explained.

Turn on the air compressor and seal the water seal in the acetylene gas and waste liquid pipes,

ignite the flame when it is safe and meet the pressure, and then put the pipette into the blank

distilled water and click the 'Zero' button to adjust the zero, and then put the pipette into the

standard blank solution, 1.0µg/mL, 3.0µg/mL, and 5.0µg/mL in sequence, and click to 'Read'

button after the signal is stable.

After clicking the 'Read' button, it will turn gray. The button will light up again to indicate

that the measurement of the sample point is complete, and the result will be saved to the data

table.

5.5.2 Calibration
Click ‘Calibration’ label in the working main interface of AAS to activate the calibration

page (As shown in Fig. 5- 30).

‘Graph Display’: After the measurements of standard series are finished, the calibration

curve will be displayed here.

‘Curve Parameters’: The calibration equation will be shown, correlation index (r),

detection limit (D.L.), and characteristic concentration (C.C.).

‘Project’: Click the drop-down list to check the calibration curve of different projects.

‘Standard Series’: Display the measuring results of standard series. Set the ‘Shield’

check box as √ can shield the abnormal points selected.
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Fig. 5- 30 Calibration

Amend Conc.: After selecting a certain concentration point, click the ‘Amend Con.’

button to edit the standard concentration value (Fig. 5- 31).

Fig. 5- 31 Amend Conc.

Add Blank: To add or cancel the measurement and frequency of the ‘Calib Blank’ and

‘Sample blank’. (Fig.5-31).

Fig. 5- 32 Add Blank

‘Equation’: Select the equation types

‘Pass Zero’: Let the calibration curve pass through the zero point.

‘Signal Type’: Select the signal types (Transient peak or Time average).

Graph Display

Project

Curve Parameters

Standard Series
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5.5.3 Results Data
Click ‘Results Data’ label in the working main interface of AAS to activate the results data

page (As shown in Fig. 5- 33). All the measuring results of standard series and unknown

samples can be checked in ‘Results Data’ page. Click the "Project" drop-down menu to

switch to view the measurement data of different analysis items.

Fig. 5- 33 Results Data

Detail: Select one sample in the sample table, then click ‘Detail’ to call out ‘Detailed Data’

window (As shown in Fig. 5- 34). Users can check the detailed data of selected sample. And

the data can be exported to Excel or printed and previewed (Excel should be installed).

Fig. 5- 34 Detailed Data



Drawell International Technology Limited

73

Reanalyze: Users can select a certain sample and click the ‘Reanalyze’ button to

remeasure. It can be redone one of the abnormal points or all of them (Fig. 5- 35). After

confirming, return to the measurement page to continue the measurement.

Fig. 5- 35 Select Reanalyze Points

Delete: The standard series and unknown samples points can be deleted by select them

and then click the ‘Delete’ button. Be careful, for if the data was deleted it will beyond

retrieve.

Data Format: Set the number of digits reserved after the decimal point of the data in the

record and calculation by clicking the ‘Data Format’ button.

Excel: The whole results data can be exported in ‘Excel’ format by click the Excel button.

Dilution: The re-diluted factor for any sample can be modified in the pop-up window by

click "Dilution" button.

Unit: Here you can modify the unit of the actual concentration after conversion of liquid

and solid samples in the output report

5.5.4 Signal Graph
Click ‘Signal Graph’ label in the working main interface of AAS to activate the signal

graph page (As shown inFig. 5- 36). The signal graphs of all the measured standard series

and unknown samples can be displayed here.
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Fig. 5- 36 Signal Graph

The signal graph of each measurement can be displayed in this page. The absorbance

signal spectrum of any measurement can be shown by clicking the sample tree on the

right to expand. The samples that have been tested and those that have not been tested

will be displayed in reverse color.

Click the ‘Set Graph’ button on the upper right corner to setup the graph parameters (As

shown in Fig. 5- 37). It could set the ‘Max’ and ‘Min’ value of displaying ABS and select

whether to automatic or overlay.

Fig. 5- 37 Graphics Setting

‘ABS Scales’: It could set the ‘Max’ and ‘Min’ value of displaying ABS. Select ‘Automatic’

to automatically adjusted by the software according to the signal diagram.

‘Show Temp’: To display the temperature curve by select graphite furnace method.

‘Overlay’: After checking, click the ‘OK’ button and a check box "□" will appear before

each measurement in the sample tree. Users can select multiple measurement signal graphs to

overlap and display and compare them in the graph display area.
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5.5.5 Report
Click ‘Report’ icon in the working main interface of AAS to activate the report page (As

shown in Fig. 5- 39).

'Print Styles': There are four print styles of the analysis report to choose:

Style 1: Analysis result. Only print the analysis result.

Style 2: Standard curve and analysis result.

Style 3: Sample pretreatment info and analysis result.

Style 4: Standard curve and sample pretreatment info and analysis result.

'Print Project': User can print all projects or just print current shown project or print the

projects selected by the check box.

'Export Word': Analysis results can be exported to Word documents or printed directly.

(Microsoft office software should be installed)

'CustomiseInfo': You can add personalized header and footer remarks to the analysis

report, which are visible during printing and previewing.

Fig. 5- 38 CustomiseInfo
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Fig. 5- 39 Report

5.6 Other Operations of AAS
5.6.1 Electronical Signature
AAS software provides an electronic signature function (purchased separately), which

can add electronic signatures to the analysis files, and can record and track the operations

performed by each logged-in user on the instrument. For a detailed introduction to the

electronic signature function, please refer to the supporting instructions in the "AAS

Audit Trail Software Instruction Manual".

5.6.2 Save and Open Files
The analysis task files can be saved as *.AAS* format by clicking the button, and the

saved task files can be opened by clicking the button and find the file save path.
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5.6.3 Print and Preview
During the analysis experiment, all five working pages of AAS (Analysis, Calibration,

Results Data, Signal Graph, and Report) can be printed and previewed respectively.

5.6.4 Wavelength Calibration
All instruments have undergone strict wavelength calibration before leaving the factory, and

the wavelength error is within the acceptable range under normal conditions. If the

wavelength error exceeds the allowable range since the optical system is affected by

transportation, maintenance or other reasons, the AAS software also provides us with a

convenient wavelength correction function. The mercury hollow cathode lamp can be used to

perform wavelength correction on the instrument. The operation method is as follows:

1) Open the AAS software to enter the main interface, then click the ‘Communication’

button to connect with the main unit;

2) Press Ctrl+F10, the icon will be added to the software toolbar, which is a shortcut

button for wavelength correction;

3) Click this button, wavelength calibration window will be popped up;(As shown in Fig.

5- 40)

Fig. 5- 40 Wavelength Calibration

4) A ‘Before Correction’ dialog box will be popped up by clicking the ‘Initialize’ button;

(As shown in Fig. 5- 41)
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Fig. 5- 41 Before Correction

5) After confirming as prompted, click the ‘OK’ button to run the calibration

initialization program.

6) Scan the six calibration wavelength points in Fig. 5- 40 above in sequence after the

initialization is completed.

7) After displaying all the scan results, click "Calc. fitting curve" to generate the

corrected "wavelength coefficient K/B". Click "Save Coef." to complete the

wavelength calibration.

5.6.5 Software Communication Settings
DW-180B Atomic Absorption Spectrophotometer adopts standard LAN network port

communication. After installing the software for the first time, it is necessary to configure the 

IP address of the computer and software. After the configuration is completed, there is no

need to change it in the subsequent use process.

5.6.5.1 Computer IP address configuration

Taking the Win10 operating system as an example, follow the steps of "Control Panel" →

"Network and Internet" (Fig. 5- 42)→ "View Network Status and Tasks" → "Ethernet"→

"Properties" (Fig. 5- 43) to open the IP address setting interface

Fig. 5- 42 Network and Internet
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Fig. 5- 43 Ethernet Properties

Manually set the computer's IP address by selecting "Use the following IP address" in the

"Internet Protocol Version 4 (TCP/IPv4) Properties" window (Fig. 5- 44). Set the IP address

to any value between "192.168.1.2 - 192.168.1.179", set the subnet mask to "255.255.255.0",

and other fields can be blank.

After the setting is complete, click "OK" to close all the setting windows.

Fig. 5- 44 Internet Protocol Version 4 (TCP/IPv4) Properties
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5.6.5.2 Software communication IP address configuration

In AAS software, click "Help"→ "Software System Setup" menu to open the software

system working configuration window (as shown in the Fig. 5- 45), enter "192.168.1.180" in

the box behind the network port communication address IP, and then click "OK"

Fig. 5- 45 Software communication IP address configuration
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6 Common fault handling

6.1 Handling of emergencies

1. Sudden power outage

In this case, the power supply of the instrument, computer and various external devices

should be turned off immediately, and various gas sources should be cut off as soon as

possible to restore the instrument to the shutdown state. After the power is turned on,

follow the instrument operation steps to turn it on again.

2. Fire exception

In this case, immediately extinguish the flame through the software, or press the

emergency stop button to turn off the gas, or directly turn off the instrument host. The

normal air-acetylene flame is light blue, and the abnormal flame is usually caused by the

abnormal gas source pressure, purity or clogging of the acetylene filter. After taking

measures to purify the gas, re-ignite.

6.2 Common fault analysis and handling

1. Dis-communication

Faults Reasons Exclusions

The instrument

is not powered

The external

power supply of

the instrument is

abnormal

Check whether the laboratory power supply and

wiring are normal

Check if the instrument is turned on

Check whether the power cord and fuse are open

circuited or in poor contact

Instrument

internal power

failure

Open the rear panel of the instrument and

measure whether the +5V, ±15V, +24V power

supply of each circuit board is normal

Poor power cord

contact

Shut down and unplug the power cord, replace

the power socket or use pliers to clamp the three

contact pins in the power socket to make it in

good contact

The instrument Abnormal power Check if the instrument is turned on
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Faults Reasons Exclusions
does not

communicate

(showing each

board

unable to

connect)

supply

Communication

line abnormal

Check whether the connection between the

instrument and the computer is firmly connected

Improper

communication

timing

The instrument automatically initializes and self-

checks when it is powered on. Please wait for the

process to end (15s～30s) before clicking the

communication button.

Instrument

internal power

failure

Open the rear panel of the instrument and

measure whether the +5V, ±15V, +24V power

supply of each circuit board is normal

2. Low energy

Faults Reasons Exclusions

Low energy

The hollow cathode emits

weak

Replace the new lamp, you can compare it

with other element lamps first

Atomizer blocks light

Check whether the optical path is blocked

or not, and correct the position of the

atomizer

Poor adjustment of the optical

path system

Readjust the optical path system to align

the light spot with the incident slit

The lens is heavily polluted

Use 1:3 alcohol and ether mixture to clean

the lens, if it is seriously dirty, replace the

lens

Contamination of slits or

optics in monochromators

Contact the after-sales service personnel,

and replace in serious cases

The performance of the high

pressure block is degraded

Replace high pressure block

Large

wavelength

error

The wavelength shift occurs

when the instrument is

newly installed or used for a

long time

Recalibrate the instrument wavelength

parameter
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3. Hollow cathode lamps failure

Faults Reasons Exclusions

Hollow cathode

lamps light off

The lamp power supply is

bad, not connected or the

lamp board is damaged

Check lamp plugs, circuit board

plugs, circuit wiring, etc.

Light leak
The lamp is damaged, replace it

with a new one

low lamp energy

Only the cathode

port emits light

The pressure of the inert gas

is reduced and the normal

discharge cannot be

maintained

End of lamp life, replace with new

lamp

Glow tone is

normal

Analysis line energy

is low

The cathode metal is

depleted or the luminous

intensity of weak light

elements (As, Te, Se, Bi, Sb,

rare earth elements, etc.) is

too weak

The lamp is used for a long time,

the cathode metal is exhausted to

the end of the lamp life, and the

lamp is replaced with a new one

Low-light element lights can only

be used with high-intensity lights

Measurement

sensitivity is low

The light emission

background is large

Replacing a lamp with a low

emission background

Abnormal light

intensity

High current

Problem with light circuit

If a single street light fails, replace

the light source driver board

If all street lights are faulty, replace

the light source substrate

Check whether the power supply

on the light board is normal

The tail of the

cathode and anode

of the lamp is

illuminated

Poor shielding between

cathode and anode, high

current breakdown

The lamp is damaged, replace it

with a new one

Light off during the

testing

Midway power outage

without detection

Simply turn off the instrument and

turn it on again
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4. Tempered

Faults Reasons Exclusions

Tempering

occurs during

instrument

flame

analysis

No water seal at the waste liquid

outlet

Add water seal

Damaged explosion-proof membrane Replace a explosion fill

Burner slit widens Replace it (the seam width is

greater than 0.7mm, there is a

risk of backfire)

Excessive oxygen content when

using air cylinders

Change to a suitable cylinder

Note: If tempering occurs, check the explosion-proof membrane if it is damaged

and replace it, and check whether the sprayer and the combustion joint are

cracked or damaged.

5. Instrument alarm

Faults Reasons Exclusions

The alarm sound

continues
Gas sensor circuit alarm

Strengthen indoor ventilation

and eliminate indoor irritating

gas interference

The alarm sound is long

and paused
Pressure sensitive circuit alarm

Check whether the air

compressor is working

properly and the pressure is

sufficient

short alarm sound Photosensitive circuit alarm

Check for strong light

exposure or blockage at the

photosensitive probe

Power on alarm

Gas-sensing alarm,

environmental conditions make

instrument parameters change

Record the details and consult

the manufacturer's technical

staff
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Faults Reasons Exclusions
The instrument does not

ignite and alarms

After a fire, it will turn

off the flame for a short

time and alarm

Air in the gas line
Fire a few times to clear the

air

Not enough air pressure
Adjust the air outlet pressure

to above 0.22MPa

No ignition and alarm

when igniting

There may be an acetylene gas

leak in the pipeline

Check pipes and connections

with soapy water

The alarm sound

continues

Long-term use, the ignition

needle oxidizes

Clean the ignition needle with

sandpaper

Ignition high pressure block

failure

Replace with new ignition

group

6. Instrument is unstable

Faults Reasons Exclusions

The instrument is

unstable when it is

not ignited, and the

instrument is

unstable after

changing the lamp

Wrong wavelength
Recalibrate the instrument

wavelength parameters

The grid voltage fluctuates

greatly
Add regulated power supply

Poor power grounding Directly ground with copper plate

The output of the high

voltage block is unstable
Replace high pressure block

There is a bad contact

component in the line

Double check each chip and plug

after shutdown

Damaged components in

the line
Factory Repair

Surrounding strong

magnetic field or high

frequency interference

Stay away from sources of

interference

The instrument is

unstable when it is

Light emission intensity is

low, negative high

pressure is too high

Increase lamp current

Widen the slit

End of lamp life, replace with a new
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Faults Reasons Exclusions
not ignited, and the

instrument is stable

after changing the

lamp

lamp

The light emission is

unstable or the light

background is large

The quality of the lamp is poor,

replace it with a new one

The instrument is

stable when not

ignited, and the

instrument is

unstable when

ignition is not

sprayed

Gas is unstable

The output pipeline of the acetylene

cylinder is leaking or the acetylene

flow meter is broken

Impure gas Enhanced filtering

Large proportion of gas,

large flame emission
Using the narrow slit

unstable air

There is a dead bend or blockage in

the air line, and the flow is not

smooth

The burner is in the wrong

position in the light path

Adjust the burner up and down, front

and rear and the angle of the

combustion head

Higher flame absorption in

the shorter wavelength

region

Turn on the background effect, or use

Cu, Mg and other lamps that are not

easily affected by flames to verify

The instrument is

stable when the

ignition is not

sprayed, and the

instrument is

unstable when the

ignition is sprayed

Impact ball position

changes

Turn off the flame and readjust the

position of the impact ball, so that the

spray is evenly forward (turning the

neck down)

Corrosion and plugging of

capillaries

Blown with air compressor or

cleaned or renewed with lotion

The waste liquid discharge

pipe is blocked
Replace with new liquid pipe

The fog room is seriously

polluted

Wash with acetone, nitric acid,

deionized water

Components produce

strong emissions in flames

Chemically remove interfering

components

Severely corroded nozzle Replace the nebulizer
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Faults Reasons Exclusions

Burner head is blocked
Refer to maintenance procedures for

flame atomization systems

There is standing water in

the line or fog chamber
Remove waste liquid

7. Incorrect results

Faults Reasons Exclusions
The

calibration

curve

does not

exceed

the zero

point

Reagents are contaminated when

preparing solutions
Reconstituted Standard Solution

Correction curve bends
Fitting a Curve Using a Quadratic

Equation

The calibration curve is not linear Reconstituted Standard Solution

Poor

sensitivity

Wrong flame View related manuals

Flame position to be optimized

Optimize the front and rear position of

the flame, or rotate the angle of the

combustion head

The sprayer is not good, the

atomization efficiency is too low

Adjust the position of the atomizer

impact ball or replace the atomizer

The slit is too wide
Refer to the analysis manual to select the

appropriate value

Lamp current is too high
Appropriate reduction of lamp current

can improve sensitivity

The nozzle is clogged and the

suction volume is too low
Clean or replace the nozzle

Inefficient atomization due to

sample viscosity

Appropriate treatment of samples to alter

their physical properties

Poor limit
The integration time is not long

enough
Prolong the time
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Faults Reasons Exclusions
The instrument is noisy Appropriately increase the current

Poor flame spray stability Check the spray status of the sprayer

Lower

value of

the result

Presence of matrix or chemical

interferences

Proper sample treatment to eliminate

interferences after verification with

standard solutions

Standard solution configuration

deviation or contamination

After verification with solutions or

samples of other elements, reconstitute

Container adsorption reduces

sample concentration

Reconstituted after verification with other

elemental solutions

Blank solution is contaminated Prepare a new blank solution

Higher

value of

the result

Unused reagent blank calibration Recalibrate with reagent blank

Ionization interference or solution

preparation problems

Add deionizer or ionization inhibitor,

reconstitute standard solvent

Inappropriate method

Change to another wavelength, use a

background corrector or use a high

temperature flame

Exists a

drift of

the result

The light intensity keeps changing
Increase warm-up time, switch to stable

lamps, or auto-zero

Lamp current adjustment

frequently

After changing the lamp current, it should

be preheated for ten minutes to stabilize

the energy

Insufficient burner preheat Preheating time (3～5)min after ignition

Capillary blockage, corrosion Clean or replace the sprayer

Poor drainage of waste liquid Replace a waste pipe

Air system is unstable

Check whether there is water in the air

system and whether the air supply is

stable
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8. Abnormal background correction

Faults Reasons Exclusions

Deuterium

lamp is

off

Deuterium lamp failure Replace with a new light

Long-term use of lamps with

increased ignition voltage

Replace the lamp with a new one when it

fails to ignite

power line failure

The measurement between the red line and

the ground is about DC200V, and between

the black and black lines is about AC10V

Incorrect software settings Set the reference signal type to "D2"

Deuterium

lamp has

low

energy

Deuterium light spot does not

enter the light path
Readjust the position of the deuterium lamp

Incorrect wavelength range

used

Deuterium lamps should be used in the

short-wave region, and the analysis

wavelength should not exceed 370nm

Long-term use, end of the light

life
Replace with new light

Correction

noise is

large

Deuterium lamp energy is low,

resulting in high gain

Adjust the energy of the deuterium lamp to

reduce the high pressure, or increase the slit

Less damping Set proper damping

Poor

correction

Poor optical path balance

Readjust the lamp current, position, etc. of

the deuterium lamp and the element lamp to

make the energy balance between the two

Element light spot

concentricity difference

Rotate the element lamp to find the position

coincident with the deuterium lamp spot

Inappropriate atomization

temperature
Choose appropriate atomization conditions

The background value of

deuterium lamp method is

greater than 1.0Abs

Beyond background correction capabilities,

reprocess samples or optimize atomization

conditions to appropriately reduce

background values
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e
software

DW-180 series instruments are equipped with special analysis software, so that users need

to install the software on the computer to operate the instrument normally. The software

realizes automatic control and optimization of instrument status and supports multi-task

analysis. The software has the functions of automatic data processing and calculation, which 

can automatically fit the working curve, reset the slope, calculate the concentration, calculate 

the sample content, etc., and has the function of electronic signature to ensure the traceability 

of the data results.

The data processing content in this software, such as the calculation of absorbance, the

calculation of slope and intercept in linear regression, the calculation of data detection limit

and relative standard deviation, etc., are strictly in accordance with the "JJG 694-2009

Atomic Absorption Spectrophotometer". Data processing and calculation shall be carried out 

according to the content specified in the relevant chapters in the Verification Regulations.

The contents not specified in the verification regulations will be explained together here.

1. Absorbance calculation

According to the content of "2 Overview" in the verification regulations, the relevant data

processing and calculation in this software are carried out. The excerpts are as follows:

Atomic absorption spectrophotometer is an instrument for quantitative analysis according to

the degree of absorption of characteristic radiation by ground state atoms of the measured

element. The measurement principle is based on Lambert Beer's law of light absorption:
�

� =− ��
�0
=− ��� = ���

Where:

A —— Absorbance

I0—— Incident light intensity;

I —— Transmitted light intensity;

T —— Transmittance;

k —— Absorption coefficient;

c —— The concentration of the tested element in the sample;

L —— The optical path of light through the atomizer.

2. Calculation of slope and intercept in linear regression
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According to the content of "Appendix A" in the verification regulations, the relevant data

processing and calculation in this software are carried out. The excerpts are as follows:

1) Equation of a straight line: � = � + ��

2) Slope: � = ���
���

3) Intercept: � = � − ��

4) Correlation coefficient: � = ���
������

Where: SCC = c2 −� ( c� )2

n
, SII = I2 −� ( I� )2

n
, SCI = cI −� c� I�

n

I——response value;

b——the slope of the working curve;

a——Intercept of working curve;

c——concentration of standard solution;

r——linear correlation coefficient;

n——the number of standard curve points.

3. Calculation of detection limit and relative standard deviation

According to the content of "5 Measuring Instrument Control" in the verification regulations,

the processing and calculation of the relevant data in this software are carried out. The

excerpts are as follows:

1) Sensitivity: S = b (flame method), S = b V (graphite furnace method)

2) Standard deviation: sA = i=1
n (I0i−I0�)2�

n−1

3) Detection limit: CL = 3sA b (flame method), QL = 3sA S (graphite furnace method)

4) Relative standard deviation: RSD = 1
I�

i=1
n (Ii−I�)2�
n−1

× 100%

5) Inversely calculate the concentration of each point: ci =
Ii�−a
b

Where: b——the slope of the working curve;

a——Intercept of working curve;

V——Sampling volume;

n——the number of measurements;

I0i——the single measured value of blank solution;

I0�——the average value of blank solution measurement;

Ii——Single measurement value of standard solution;
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I�——the average value of standard solution measurement;

Ii�——The average value of each point measurement.

4. Other instructions

For the data processing and calculation content not specified in "JJG 694-2009 Atomic

Absorption Spectrophotometer Verification Regulations", it shall be specified in this software

according to "GB/T 21187-2007 National Standard for Atomic Absorption

Spectrophotometer";

For the data processing and calculation contents that are not stipulated in the verification

regulations or national standards, they are stipulated in this software according to the product

enterprise standards.

Some descriptions are as follows:

1) Standard concentration: the software calculates the absorbance value of the standard

point, and the absorbance value of the standard blank has been deducted.

2) Actual concentration: The software calculates the actual concentration of the sample

point, and the blank concentration of the sample has been deducted.

3) Data digits: The display of data in the data table and the working curve page and the

digits used for calculation are shown in the following table.

Data type

Display digits after decimal point

Default
Number of digits that can be

set

Data

sheet

interface

Absorbance 3 1~6

standard deviation 6 1~6

The relative standard deviation 4 1~6

Back-calculated concentration, actual

concentration
4 1~6

Work

curve

interface

Working curve slope, intercept 6 —

Linear correlation coefficient 6 —

The detection limit 6 —

Feature concentration, feature quantity 6 —
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Chongqing Drawell Instrument Co.,Ltd.
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Tel: 0086-023-63268643
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